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Welcome to CarChip 
 Welcome to CarChip!  

 

Click on one of the following topics to find out more information on using the CarChip system: 

Getting Started Topics 
Use the following topics to start using your CarChip device and software: 

How CarChip Works 

CarChip Installation 

Example File 

Walkthrough Express Setup 

Walkthrough Full Setup 

Downloading CarChip Data 

Viewing Data 

Exporting Data 

Printing 

Toolbar 

Using CarChip Help 

Menu Commands 

Use the following topics to learn more about the menus available in the CarChip software: 

File Menu Commands 

Setup Menu Commands 

CarChip Menu Commands 

Tools Menu Commands 

View Menu Commands 

Help Menu Commands 

More Information  
What's New in CarChip 2.3.3 

CarChip Prior Release Notes 

CarChip Online Help Printable Document 

CarChip Specifications 

Incompatible Vehicle List 

One Year Limited Warranty 

1 



CarChip Online Help Printable Version 

Contacting Davis Instruments 

 

Home | File | Setup | CarChip | View | Help | Shortcuts 
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Getting Started 

Getting Started 

Use the following topics to start using your CarChip device and software: 

How CarChip Works 

CarChip Installation 

Example File 

What's New in CarChip 2.3.3 

Walkthrough Express Setup 

Walkthrough Full Setup 

Downloading CarChip Data 

Viewing Data 

Exporting Data 

Using the File Menu 

Printing 

Toolbar 

Using CarChip Help 

 

Back to Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

How CarChip Works 

The CarChip Pro plugs into the OBDII port in many 1996 or newer cars or trucks to record trip and 
performance data. This data is then downloaded into your PC computer, providing a detailed look at how 
the vehicle was driven, including trip start and end times, vehicle speeds, rates of acceleration and 
braking, and also any OBDII trouble codes detected during the trip. The CarChip software displays vehicle 
data in summary, plot or table format, and can also be exported to Microsoft Excel for further analysis. 
The CarChip Pro also logs additional engine and vehicle data parameters, including an accident log which 
records 20 seconds of vehicle speed history prior to every sudden stop. 

Use CarChip Pro (# 8226) for: 

• Troubleshooting your car - Records trouble codes and displays freeze frames of sensor readings. 

• Logging your car's performance - Records acceleration, deceleration, and speed.  

• Recording trip information - Records dates, starts and stops, and distance. 

• Clearing your car's check engine light - Checks your car's sensors and turns off the check engine 
light. 
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• Engine performance data logging - Log up to 4 of 23 available data parameters. 

• Creating an Accident Log for every extreme stop. 

• Announcing to driver when speed, braking, and acceleration thresholds have been 
exceeded - Gives off an audible alarm when thresholds have been broken. 

Use CarChip Fleet Pro (# 8246) for: 

• Downloading car information to both the CarChip software and the DriveRight Fleet 
Management Software (# 8186) 

   
See Also: 

CarChip Installation 

What is OBDII 

Information on Discontinued CarChip Models 

 

Back to Getting Started 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

CarChip Installation 

CarChip Installation 
The following help topics show you how to connect CarChip to your car, to your computer, and how to 
install the CarChip software. This information is also included in the CarChip packaging. 

Connecting the CarChip Pro to a Car 

Connecting the CarChip Pro to a Computer 

Installing CarChip Software 

Connecting an Older Model CarChip to a Computer 

 

Back to Getting Started 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Installing CarChip in your Car 
Follow these steps to install the CarChip data logger in your car. 

 

1. Find the OBDII port on your car.  

 

The OBDII port is located within 3 feet of the steering wheel, usually near the general area indicated by 
the dotted line in the following illustration. The port should be easily accessible to a person in the driver's 
seat.  
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Note: Use the Davis Instruments' CarChip web site to locate the OBDII connection on your car. 

2. Check the following areas for the OBDII port: 

Under the Dash Behind a small access panel in the dash 

In front of the passenger seat In or around the center console 

Behind the ash tray  

3. Plug the CarChip data logger into the OBDII connector. 

 

Note: If the indicator light is enabled, which is its default setting, it continuously blinks when connected to 
a vehicle. If the indicator is disabled, it stops blinking once is has established communication with the 
OBDII computer. 
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4. Check to make sure the data logger indicator light is blinking. This verifies CarChip was properly 
inserted into the OBDII port and is communicating with your vehicle. 

 

 

Back to Home | CarChip Installation 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Connecting CarChip Pro to a Computer 
The CarChip Pro or CarChip Fleet Pro data logger (# 8226, 8246) connects to your computer using a USB 
connection.  

To connect the CarChip Pro data logger to your computer using a USB connector: 

1. Insert the USB connector of the download cable into a USB port. 

2. Plug the smaller connector into the CarChip Pro  (# 8226) or CarChip Fleet Pro (# 8246) data logger 
port. 

 

 

 

See Connecting an Older Model CarChip to a computer if using a different model of the CarChip than the 
one shown. 
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Back to Home | CarChip Installation 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Installing CarChip Software 
Follow the steps provided below to install the CarChip software. CarChip software is compatible with 
computers running Windows™ 98SE, ME, NT 4.0, 2000, XP, or Vista. 

1. Place the CarChip software CD in your CD ROM drive. 

2. The install program should start automatically. If the install program does not start, select Run from 
the Start menu, type D:\SETUP (or the correct letter for your CD ROM drive), and click OK to begin 
the installation. 

3. Follow the on-screen prompts to complete the installation. 

 

Back to Home | CarChip Installation 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Connecting an Older Model CarChip to a Computer 
The older models of the CarChip data logger connect to your computer using a USB connection (# 8211, 
8221, 8225, 8241, 8245) or using a serial port connection (# 8210, 8220). See Connecting CarChip Pro to 
a Computer if you have a CarChip Pro or CarChip Fleet Pro (# 8226, 8246).  

Note: The CarChip data logger does not have to maintain a constant connection with your computer. The 
CarChip can be connected and disconnected at any time the CarChip software is not downloading 
information from the CarChip data logger. 

To connect the CarChip data logger to your computer using a USB connector: 

1. Locate a free USB port on the front or back of your computer and insert the USB connector of the 
download cable into the USB port. 

2. Plug the microminiature connector into the port on the CarChip data logger. 
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To connect the CarChip data logger to your computer using a serial port: 

The following instructions for connecting earlier versions of the CarChip (products # 8210, # 8220) to a 
 serial port connection:  

1. Locate a free serial port on the back of your computer and insert the 9-pin connector of the 
download cable into the port. 

2. Plug the power adapter cable into the power jack on the 9-pin connector. 

3. Plug the power supply into an AC outlet. 

4. Plug the 8-pin microminiature connector into the port on the CarChip data logger. 

 

Back to Home | CarChip Installation 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

7 



CarChip Online Help Printable Version 

 

Example File 

Sample data is automatically loaded and displayed in the CarChip software when the software is installed 
and opened for the first time. Use the sample data to view the functionality that exists in the CarChip 
software.   

To display the example data: 

1. The Example File dialog box displays when the CarChip software is first opened. This dialog box 
displays an alert that a file with sample data will be opened and displayed. Click OK to open the 
sample data file. 

 

The sample data file, Example.car, is located in your CarChip software directory and can also be manually 
opened. 

To manually open the example file: 

1. Select Open in the File Menu. The Browse dialog box displays. 

2. Select the Example.car file in the CarChip program directory. The CarChip program directory is 
located in the directory where you installed the CarChip Software. In this example, the directory is 
C:\Program Files\CarChip. 

3. Click Open to load the example file into the software. Click Cancel to exit the dialog box without 
opening the file. 

 

Back to Getting Started 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Downloading CarChip Data 

Once you have connected your CarChip data logger to your computer, you are ready to download data 
from any of the CarChip models.   

To download data: 

1. Click the Download CarChip icon or select Download CarChip Data from the CarChip menu.  
 
In some instances, the Warning Clock Setup dialog box displays. When data is downloaded, the 
software automatically compares the internal clock on the CarChip against the clock on your 
computer. Click OK to continue or check Synchronize Clocks to set the CarChip data logger's 
internal clock to your computer's clock. 
 
The Downloading Logs status dialog box displays. Click Cancel to abort the download before it is 
finished. The Downloading Logs dialog box closes when the download is complete. 
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2. The Question dialog box displays. The Question dialog box asks if you want to delete the data 
currently in the CarChip memory. 

 

3. Click No to keep the current data in the CarChip device, or click Yes to clear the CarChip memory. 

Note: This dialog box contains a Don't Ask Again check box. By Checking this option and clicking Yes, 
the CarChip's memory is automatically cleared after every download. By clicking No, the CarChip's 
memory is never cleared after download. To change your CarChip memory clearing options, see Memory 
Clearing Options. 

The Unidentified Vehicle/Driver dialog box displays. See Unidentified Vehicle/Driver ID for more 
information on this dialog box.  

Once you have finished associating vehicles and drivers with the downloaded trip data, the Activity Log 
Summary view automatically displays the downloaded data. 

 

Back to CarChip Menu | Getting Started 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

Unidentified Vehicle/Driver ID 

The Unidentified Vehicle/Driver ID dialog box displays once data has been downloaded from the CarChip 
data logger, prompting you to select the vehicles and drivers associated every trip that was recorded. The 
CarChip device is capable of being connected to multiple vehicles. Every time the CarChip is connected to 
a vehicle, a connection event is recorded. The Unidentified Vehicle/Driver ID dialog box displays for 
every connection event that has been recorded in the CarChip device, with the date and time the 
connection occurred. From this dialog box, select the drivers and vehicles associated with every 
connection event.  
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To select a vehicle and driver associated with each connection event: 

1. Select the vehicle name from the Vehicle box.  
 
If no vehicle exists, or if the vehicle that is associated with the event is not listed, see Creating a 
New Vehicle. If you select the wrong vehicle for the displayed VIN, you may correct this after the 
 download by changing the vehicle name in the Vehicle ID dialog box.  

To create a new vehicle to associate with each connection event: 

1. Click New next to the Vehicle box.  
 
The New Vehicle Dialog Box displays. 

2. Enter a unique vehicle name or the vehicle's VIN number in the VIN box. 

3. Enter a unique vehicle name in the Name box and click OK. 
 
You do not have to enter a name in the name box. Click OK if you want the information 
displayed in the VIN box to display in the Name box. 

The new vehicle information displays in the Vehicle box. 

2. Select a driver name from the Driver box. 
 
If no driver exists, or if the driver that is associated with the event is not listed, see Creating a New 
Driver. 

To create a new driver to associate with each connection event: 

1. Click New next to the Driver box.  
 
The New Driver Dialog Box displays. 

2. Enter a unique driver name or ID in the ID box. 

3. Enter a name in the Name box and click OK. 
 
You do not have to enter a name in the name box. Click OK if you want the information 
displayed in the ID box to display in the Name box. 

The new driver information displays in the Driver box. 

3. Click OK to associate the selected vehicle and driver with the connection event.  
 
If the driver and vehicle are associated with all the connection events stored on the CarChip, select 
Apply To All.  
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Once all connection events have been associated with a vehicle and driver, the dialog box closes and 
the summary report for the Trip Log displays. 

 

Back to Downloading CarChip Data | Getting Started 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Assign Drivers 

The Assign Drivers dialog box displays if a CarChip file from a previous version of the CarChip software 
(CarChip 1.3 or earlier) has been added. This dialog prompts you to assign drivers associated with every 
trip that was recorded.  The Assign Drivers dialog box displays for every trip present in the CarChip file. 
From this dialog box, select the drivers associated with every trip.  

To Assign Drivers: 

1. Open a .car file from an earlier version of the CarChip Software. 
 
The Assign Drivers Now? dialog box displays. 

 

2. Click Yes to assign drivers to trip information.  
 
The Assign Drivers dialog box displays. 

 

3. Select a driver name from the Driver drop down box, or click New to assign a new driver to the trip 
or trips. 

4. Click OK to associate the driver to the displayed trip. Click Skip to skip assigning a driver to the 
displayed trip. Click Apply to All to associate the selected driver to all the trips. 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

View Menu Commands 

The View menu commands allow you to view Trip Log, Activity Log, Accident Log, Vehicle Trouble Log and 
Summary Log information. 

Note: The Accident and Summary Log menu commands are only available for CarChip data logger model 
E/X or higher.  
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Use the following topics to learn more about each log view: 

CarChip Home Page 

Trip Log 

Activity Log 

Accident Log 

Vehicle Trouble Log 

Summary Log 

 

Back to Home | Getting Started 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

Exporting Data 

You can export logged data from the Trip, Activity, Accident, and Trouble Log views using the menu that 
displays when you right-click on a log report. There are several options and formats available for 
exporting data. The available options are: 

• Information displayed in any of the Log Views can be exported by either saving to a file or copying to 
the clipboard. Copying to a clipboard allows you to paste the information directly into other 
applications. 

• Trip, Activity, Accident, and Trouble summary, report, and table views can be exported as either a 
text file or a data file.  

• Plot views can be exported as a metafile (vector graphic format), bit-mapped graphics file, or as 
data.  

Data files are tab delimited text files that can be imported into a spreadsheet. 

 

See Also: 

Right Click Copy As 

Right Click Save As 

Right Click Copy Plot As 

Right Click Save Plot As 

 

Back to Getting Started 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

File Menu Commands 

With the options in the File menu you can save your downloaded CarChip data, open previously saved 
data, and print your data. 

12 
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• New - Closes existing CarChip data and the corresponding file so that new CarChip data can be 
downloaded and displayed. 

• Open - Opens an existing CarChip data file. 

• Save - Saves the CarChip data currently displayed in the software. The data is saved in specially 
formatted CarChip file called a .car file.  

• Save As - Lets you specify a new file name when you save CarChip data.  

• Properties - Displays information about the data file currently loaded in the CarChip software. This 
command is only available when you are viewing data loaded from a file or that has been 
downloaded from the CarChip data logger and saved. 

• Print Setup - Allows you to select a printer and configure printer options. 

• Print Preview - Shows how the current log or data display would look like in a printed document. 

• Print - Prints the currently displayed window. 

• Exit - Closes the CarChip software. 

 

Back to Getting Started  

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Toolbar 

The Toolbar provides a quick way to access CarChip software commands.  

 

Toolbar Icons 

 
Home - Displays the CarChip Home Page, containing vehicle and driver summary 
information. 

 
Download - Downloads data from the CarChip data logger. 
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Trip Log Report View - Selects the last Trip Log Report View. 

iew. 

 

ary page. 

 open page. 

ens the CarChip Help file. 

avigation Buttons 

 

 

ols | View | Help | Shortcuts 

Navigation Buttons 

 
Trip Log Plot View - Selects the last Trip Log Plot V

 
Trip Logs - Displays the Trip Log Summary page. 

 
Activity Logs - Displays the Activity Log Summary page. 

 
Accident Logs - Displays the Accident Log Summary page.

 
Trouble Logs - Displays  the Trouble Log Summ

 
Print - Prints the current open displayed page. 

 
Print Preview - Previews the current

Help - Op

 
 

See Also: 

N

Shortcuts and Navigation Aids 

Back to Getting Started 

Home | File | Setup | CarChip | To
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Trip Log Navigation Buttons 

se the lef w: U t and right arrow navigation buttons to select records in the Trip Log Vie

 

   Back - Click the left arrow button to display the previous trip record. 

 

   Forward - Click the right arrow button to display the next trip record. 

 

se the up Log Plot View: U  and down arrow navigation buttons to select plots in the Trip 

 

    Up -  Click the up arrow button scroll up to the next plot.  

 

   Down  -  Click the down arrow button to scroll down to the next plot. 

 

ccident Log Navigation Buttons 

se the lef w: 

A

U t and right arrow navigation buttons to select records in the Accident Log Vie

 

   Back - Click the left arrow button to display the previous accident record. 

 

    Forward - Click the right arrow button to display the next accident record. 

 
ome | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

al aids can help you move quickly through the logged data 
. These shortcuts work when viewing any log record. Use these shortcut keys to: 

Down cursor key - Move to next record. 

 

 

Back to Trip Log View | Accident Log View 

  
H

 

 

 

Shortcuts & Navigation Aids 

The following keyboard shortcuts and navigation
views

Up cursor key - Move to the previous record.
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These apply to the buttons labeled "Report, Plot, and Table"  when viewing individual reports in the trip 
log. Use these shortcut keys to: 

he right of the current selection. 

e apply to any log view that will not completely fit on one screen. Use these shortcut keys to: 

e screen. 

 Trip Log View and Accident Log View 
s. Use these buttons to: 

and accident 

Left cursor key - Select button to the left of current selection. 

Right cursor key - Select button to t

 

Thes

Page up key - scrolls up the screen. 

Page down key - scrolls down th

 

The following buttons are navigation aids that are only available in
Plot

Back - Display the previous trip or accident record. 

Forward - This command displays the next trip or accident record 

that are only available in Trip Log View Plots. use these buttons 
: 

 

The following buttons are  navigation aids 
to

Up -  Scrolls up to the next plot. 

wnDo   -  Scrolls down to the next plot. 

me 

 

 | Shortcuts 

 

k Menu Options 

ing Right-Click menu options are available when viewing log summaries, individual records, 
ews: 

lso: 

ing Trip Plots 

ip View | Activity View | Accident View | Trouble View 

View | Help | Shortcuts 

 

 

Back to Ho

Home | File | Setup | CarChip | Tools | View | Help

Right Clic

The follow
and table vi

Copy As 

Save As 

Help F1 

 

See A

Viewing Accident Plots 

View

 

Back to Tr

 

Home | File | Setup | CarChip | Tools | 

Right Click Copy As 
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The Copy As command available in the Right-Click menu for the Summary, Record, and Table Views 
offers two file formats for copying the displayed information: text and data. 

 

• Copy As > Text - Paste the displayed information as text in another application. 

ion as tab delimited text in a spreadsheet program.  

me | File | Setup | CarChip | Tools | View | Help | Shortcuts 

• Copy As > Data -  Paste the displayed informat

 

Return to Right Click Menu Options | Exporting Data 

 

Ho

 

Copy Plot As 

The Copy As command in the Plot View right-click menu offers three options for copying the displayed 
information: metafile, bitmap, and data. The Copied information can then be pasted directly into another 
application. 

 

to another application as a vector graphics file. 

 into another application as bitmapped paint file. 

a spreadsheet program.  

g Data 

| Help | Shortcut 

• Copy As > Metafile - Copies the plot in

• Copy As > Bitmap - Copies the plot

• Copy As > Data - Copies the plot data as

 

View 

The Save As

 tab delimited text into 

 

Return to Trip Log Plot View | Accident Log Plot View | Exportin

Home | File | Setup | CarChip | Tools | 

Right Click Save As 

 command available in the Right-Click menu for the Summary, Record, and Table Views 
offers two file formats for saving the displayed information: text and data. 
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• Save As > Text - Pastes the displayed information as text in another application. 

• Save As > Data -  Paste the displayed information as tab delimited text in a spreadsheet program.  

 

Return to Right Click Menu Options | Exporting Data 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Save Plot As 

The Save As command available in the Right-Click menu for the Plot View offers three file format options 
for saving the displayed information: Metafile, Bitmap and Data. 

 

• Save As > Metafile - Saves the plot as a vector graphics ".emf" file. 

• Save As > Bitmap - Saves the plot as bitmapped paint ".bmp" file. 

• Save As > Data - Saves the plot data as a tab delimited text ".txt" file for use in a spreadsheet 
program.  

 

Return to Trip Log Plot View | Accident Log Plot View | Exporting Data 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Using CarChip Help 

Here is some information on getting started and using CarChip Help:  

Context-Sensitive Help 

• Tool Bar Help Button - Opens the help topic for the active CarChip window. 
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• Dialog Box Help Button - Opens the help topic for that dialog box. 

• F1 Key - Opens the help topic for the active dialog box or the active CarChip window. 

CarChip Hyperlink Conventions 

Blue Underline : indicates link to CarChip help topic. When selected, the new topic replaces the previous 
topic in the window. 

Bold blue Underline : indicates link outside of CarChip Help to information such as an external help 
topic, web page, or documents in the  program directory. Open this link in a new window that uses your 
default web browser. 

Green Underline : indicates drop-down text or illustrations that display below the drop-down link in the 
current help topic window. 

Using Windows HTML Help 

If you have Internet Explorer installed on your computer, CarChip Help opens in the Microsoft HTML Help 
viewer. If you don't have Internet Explorer, it opens your default browser.  

To learn more information about using the Microsoft HTML Help Viewer, click the following links.  

Resizing the HTML Help viewer  

To: Do this 

To minimize the window Click Minimize to shrink the viewer so it is displayed in the button bar 
on the bottom of the Windows Desktop. Right-click this button and select 
Restore to display the viewer. 

To maximize the window Click Maximize to maximize the window so it occupies the entire 
desktop area. 

 

To restore the viewer to 
its default size 

 Click Restore  to restore the viewer to it's default size. 

 

To manually resize the 
viewer 

 

Place the pointer over the edge of the viewer so it turns into a line with 
arrows on each end . Press the left mouse button and drag up, down, 
left or right. The viewer is resized after you release the mouse button. 

Opening and closing the left-hand panes 

To: Do this 

Close the left-hand tabs from view Click Hide 

Open the left-hand tabs Click Show 

 

Using the navigation buttons 

To: Do this 
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Display the previous topic 
going backwards in your 
topic selection sequence. 

Click Back 

Display the next topic going 
forward in your topic 
selection sequence. 

Click Forward 

 

Using the Options menu 

The Options button opens a menu with selections for hiding the left-hand tabs, going back and forward, 
stopping a topic or Web page from loading, refreshing the information displayed in the window, printing, 
and turning search highlighting on or off. You can also access Internet options from this menu. 

   

Back to Getting Started  

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Menu Commands 

Menu Commands 

Click on a topic below to view help for a particular menu: 

File Menu 

Setup Menu 

CarChip Menu 

View Menu 

Help Menu 

 

Back to Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

File Menu Commands 

With the options in the File menu you can save your downloaded CarChip data, open previously saved 
data, and print your data. 

• New - Closes existing CarChip data and the corresponding file so that new CarChip data can be 
downloaded and displayed. 

• Open - Opens an existing CarChip data file. 

• Save - Saves the CarChip data currently displayed in the software. The data is saved in specially 
formatted CarChip file called a .car file.  

• Save As - Lets you specify a new file name when you save CarChip data.  
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• Properties - Displays information about the data file currently loaded in the CarChip software. This 
command is only available when you are viewing data loaded from a file or that has been 
downloaded from the CarChip data logger and saved. 

• Print Setup - Allows you to select a printer and configure printer options. 

• Print Preview - Shows how the current log or data display would look like in a printed document. 

• Print - Prints the currently displayed window. 

• Exit - Closes the CarChip software. 

 

Back to Getting Started  

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Setup Menu Commands 

Setup Menu Commands 
The Setup menu commands configure various aspects of the CarChip software, including how the data is 
displayed and the connection between CarChip data logger and the CarChip software. The Setup menu 
commands are: 

Walkthrough - Express Setup - Displays all the setup dialog boxes needed to configure your CarChip 
software and CarChip data logger connection for first time users. 

Walkthrough - Full Setup - Displays all the setup dialog boxes needed to configure your CarChip software 
and CarChip data logger connection. 

Communication Port - Lets you manually select the serial or USB port connection the CarChip data logger 
uses to send information to your computer. 

Plots - Contains options for displaying plots and graphs. 

Units - Lets you select the unit systems used to display data measurements. You can also create your own 
customized unit system. 

Parameter Thresholds - Lets you create thresholds for certain parameters of your vehicle's performance 
that the CarChip data logger monitors.  

Note: This command is only available for CarChip E/X models or higher. 

Driver ID - Displays all of the drivers associated with the CarChip data logger. 

Vehicle ID - Displays all of the vehicles associated with the CarChip data logger. 

CarChip ID - Displays information about the CarChips that have been connected with the CarChip 
software. 

Miscellaneous - Lets you configure the options for clearing the CarChip data logger's memory. 

 

Back to Home 
  

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Walkthrough Menu 
The CarChip software includes a two walkthrough options that step you through the process of configuring 
your CarChip data logger and CarChip software configurations: 
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• Express Setup - Displays the essential dialog boxes and screens for configuring your CarChip and 
software features, such as driver and vehicle information and logging parameters.  

• Full Setup - Displays all dialog boxes and screens used to configure varying areas of your CarChip 
and the software, such as plotting features and units of measure. 

After installing the CarChip software on your computer and opening the program, the Walkthrough 
Selection dialog box automatically displays. By clicking Express Setup, the express walkthrough process 
begins.  By clicking Full Setup, the full walkthrough process begins. You can set up and configure your 
CarChip data logger and software by separately selecting all of the necessary setup options from the 
Setup menu. Individual Walkthrough commands are included in the Walkthrough sub-menu in the 
 Setup menu so that you can access each individual walkthrough process at any time. 

 

 

Back to Getting Started | Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

Walkthrough - Full Setup 
The CarChip software includes a full walkthrough that steps you through the full process of configuring 
your CarChip data logger and CarChip software. This process is useful for a first time or returning user 
that would like a step through guide to configuring and setting up all aspects of the CarChip and the 
software. After installing the CarChip software on your computer and opening the program, the 
Walkthrough Selection dialog box automatically displays. By clicking Full Setup, the full walkthrough 
process begins.  A full Walkthrough command is included in the Setup menu so that you can access the 
full walkthrough at any time. Alternately, you can set up and configure your CarChip data logger and 
software by separately selecting all of the necessary setup options from the Setup menu. 
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Note: The CarChip data logger does not have to be connected to your computer to use the Full Setup 
option. Without the CarChip connected, the Full Setup displays the essential software features only. When 
the CarChip data logger is connected, the other setup commands pertaining to the CarChip are available. 

By selecting the walkthrough process, the software displays a series of dialog boxes listed below. At each 
step in the walkthrough process, confirmation boxes are provided to perform or skip the next step in the 
walkthrough. To continue, click OK. To skip a step and move to the next step, click Skip. To cancel the 
entire walkthrough process, click Cancel. 

Walkthrough Sequence 
The dialog boxes included in the full walkthrough vary depending on the CarChip data logger model you 
have and whether your CarChip is connected to your computer. 

Available when CarChip is plugged in: 

• CarChip / Set Speed Bands - Enter the threshold speeds for the CarChip data logger. The 
threshold speeds help you identify how much time is spent in each speed band. The time spent in 
each band shows up on the Trip Report and is displayed as horizontal dotted lines in the Trip 
Speed Plot. 

• CarChip / Set Braking Thresholds - Enter the rates of deceleration that define hard braking and 
extreme braking. 

• CarChip / Set Acceleration Thresholds - Enter the rates of acceleration that define hard 
acceleration and extreme acceleration. 

• CarChip Parameter Report - Displays the vehicle data parameters the CarChip has been set to 
record, if any are available. 

23 



CarChip Online Help Printable Version 

 

• CarChip/Choose Other Parameters - Set vehicle data parameters that the CarChip records. You 
can select up to four different parameters in addition to vehicle speed to record. 

Note: This dialog box displays only for CarChip models E/X or higher.  

• Parameter Thresholds - Set thresholds for parameters monitored in the Summary Log view. 

Note: This dialog box displays only for CarChip models E/X or higher. 

• Anomalous Vehicles - Specify the vehicle in which the CarChip will be used. Some vehicles have 
special OBDII communication properties. By selecting a vehicle name from the list, you are 
configuring the CarChip data logger to adjust to that vehicle's unique communication features. 

CarChip software features: 

• Plots - Select the options for displaying plots and graphs. 

• Select Units - Select the units of measure to be used for displaying data and information. 

• Miscellaneous - Select an option for clearing your CarChip's memory. 

• Driver ID - Add, delete, or edit the list of drivers using the CarChip data logger. 

• Vehicle ID &endash; Add, delete, or edit the list of vehicles using the CarChip data logger. 

• CarChip ID - Edit the CarChip data logger names. 

• CarChip Download - If the CarChip already has available data, lets you download the data now. 
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• Clear CarChip Memory - Click Yes to delete CarChip memory after download. Click no to keep 
memory on CarChip after download. 

• CarChip / Set Clock - Set the CarChip data logger's internal clock to match your computer's clock. 

 

Back to Getting Started | Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Walkthrough - Express Setup 
The CarChip software includes an express walkthrough that steps you through the dialog boxes and 
screens in the software that are essential for configuring your CarChip data logger and CarChip software 
as a first time user. After installing the CarChip software on your computer and opening the program, the 
Walkthrough Selection dialog box automatically displays. By clicking Express Setup, the express 
walkthrough process begins. The Express Walkthrough command is included in the Setup menu so that 
you can access the express walkthrough at any time. You can alternately configure your CarChip data 
logger and software by separately selecting all of the necessary setup options from the Setup menu. 

 

Note: The CarChip data logger does not have to be connected to your computer to use the Express Setup 
option. Without the CarChip connected, the Express Setup displays the essential software features only. 
When the CarChip data logger is connected, the other setup commands pertaining to the CarChip are 
available. 
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By selecting the express walkthrough process, the software displays a series of dialog boxes listed below. 
At each step in the walkthrough process, confirmation boxes are provided to perform or skip the next step 
in the walkthrough. To continue, click OK. To skip a step and move to the next step, click Skip. To cancel 
the entire walkthrough process, click Cancel. 

Walkthrough Sequence 
The dialog boxes included in the express walkthrough vary depending on the CarChip model you have and 
whether your CarChip is connected to your computer. 

Available when CarChip is plugged in: 

• CarChip Parameter Report - Displays the vehicle data parameters the CarChip has been set to 
record, if any are available. 

 

• CarChip/Choose Other Parameters - Set vehicle data parameters that the CarChip records. You 
can select up to four different parameters in addition to vehicle speed to record. 

Note: This dialog box displays only for CarChip models E/X or higher.  

• Anomalous Vehicles - Specify the vehicle in which the CarChip will be used. Some vehicles have 
special OBDII communication properties. By selecting a vehicle name from the list, you are 
configuring the CarChip data logger to adjust to that vehicle's unique communication features. 

CarChip software features: 

• Add Driver/Vehicle ID - Add, delete, or edit the list of drivers and vehicles using the CarChip data 
logger. 

• CarChip Download - Lets you download the CarChip if it already has available data. 
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• Clear CarChip Memory - Click Yes to delete CarChip memory after download. Click no to keep 
memory on CarChip after download. 

• CarChip / Set Clock - Set the CarChip data logger's internal clock to match your computer's clock. 

 

Back to Getting Started | Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

Anomalous Vehicles 
The Anomalous Vehicles dialog box lets you configure your CarChip data logger to meet any unique 
specifications present on the OBDII port of your vehicle. This dialog box displays as part of the 
Walkthrough Setup. This dialog box also displays if a vehicle from the Anomalous Vehicle list has been 
detected by the CarChip data logger once the CarChip is connected to the software.  

Caution: Most vehicle have standard OBDII capabilities. If CarChip is set to work with an 
exception vehicle or protocol, it will not work with a vehicle that has standard OBDII 
capabilities. 

To select your vehicle: 

1. Click OK on the Special OBDII Communication Properties dialog box from the Walkthrough Setup 
or select Set as Anomalous Vehicle from the CarChip Menu. The Anomalous Vehicle dialog box 
displays. 
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2. Click the Vehicle with Standard OBDII Capabilities radio button if your vehicle is not present 
in the Specific Exceptions list or you do not want to select a specific protocol.  Click the Specific 
Exceptions radio button if your vehicle is present in the list and select the vehicle name. Click 
the Specific OBDII Protocols radio button if the specific protocol your vehicle is using is 
present on the list.  

3. Click OK to save the anomalous vehicle information, or click Cancel to exit the dialog box 
without saving the information. 

The Specific Vehicle Exceptions include: 
  

• Ford Focus ZXL2003 2.3L 

• Toyota Hybrid 

• Ford/Mercury Hybrid 

• Honda/Saturn Hybrid 

• Renault EOBD (Available in CarChip data loggers with firmware version 3.12 or later,  CarChip 
Software 2.3.2 or later) 

• Intermotive Capability Vehicles (Available in CarChip data loggers with firmware version 3.12 or 
later, CarChip Software 2.3.2 or later) 
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• Ford F-Series Diesels (Available in CarChip data loggers with firmware version 3.18 or later, 
 CarChip Software 2.3.3 or later) 
  

The OBDII Protocols include: 
  

• VPW (J1850-10.4) - Protocol used in  some Chrysler, Buick, Chevy, Dodge, GMC, GM, Isuzu, 
Jeep, Mercury, Oldsmobile, Pontiac and Saturn Vehicles 1996 - 2004. 

• PWM (J1850-41.6) - Protocol used in most Ford vehicles 1996 to 2006. 

• ISO ( ISO9141) - Protocol used in some Volkswagon, Porsche, Volvo, Toyota, Subaru, Nissan, 
Infinity, Mercedes Benz, Mazda, Landrover and Kia vehicles from 1996 to 2004. 

• KWP (KWP2000, ISO 14230) - Protocol used in some BMW, Audi , Porsche , Suzuki, Subaru 
and Volkswagon vehicles 2003 and earlier. 

• CAN ((Control Area Network ISO 11898) - Protocol used for most vehicles 2004 and later. 

The Specific OBDII Protocols list is available for CarChip data loggers with firmware version 3.12 or later 
and in CarChip software 2.3.2 or later.  See the CarChip web site for more information on updating the 
CarChip firmware.  

If your vehicle is not listed in the Specific Vehicle Exceptions, but if you are observing odd behavior, it 
may be that the CarChip is trying to initialize a protocol that your vehicle does not use. When the CarChip 
is first connected to a vehicle it cycles through the list of protocols to find the protocol that the vehicle is 
using. If a protocol is selected from the list, the next time the CarChip is placed in a vehicle the selected 
protocol is used. Do not select a specific protocol if you do not know your vehicle's protocol. Contact 
Technical Support for assistance regarding selecting a specific protocol if you are uncertain. 

   
Back to Walkthrough - Express Setup | Walkthrough - Full Setup | CarChip Menu 
  

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Communications Port 
The Communications Port dialog box lets you manually select the port connection  that is used to 
communicate with your CarChip data logger. This command can be accessed from the Walkthrough Setup 
or the Setup menu.  

Note: If your CarChip data logger has been connected to a serial port or USB port and has been detected 
by the CarChip Software, this dialog box does not display in the walkthrough process. 

To select the communications port connection manually: 

1. Select Communications Port from the Setup menu. The Setup / Communications Port dialog box 
displays. 
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2. Select one of the listed ports or enter the name of the desired port.  
 
Select USB if the CarChip is connected to a USB port. Select one of the available COM ports if the 
CarChip is connected to a Serial or COM port, or type in the name of the COM port if it is not on the 
available list.  

3. Click OK to save the new port selection, or click Cancel to exit the dialog box and retain the previous 
port selection. 

 

Back to Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Plots 

Plots 
Use the Plots dialog box to configure your Trip View and Accident View plot options. 

To configure the plot display options:  

1. Select Plots from the Setup menu, select this option during the Walkthrough Setup process, or click 
the Options button when a Trip Log view or Accident Log view is displayed. The Setup / Plots dialog 
box displays. 

 

2. Check the box next to each plot option to turn it on. A checked box indicates the option is turned on. 
De-select a box to turn a plot option off. Multiple options can be turned on or off at a time. The plot 
options are: 
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• Draw Speed Bands - Displays your selected speed band settings in the plot.  

• Draw Braking Events - Marks braking events that exceed your preset braking thresholds.  

• Draw Acceleration Events - Displays acceleration events that exceed your preset acceleration 
thresholds. 

• Draw Plots using Lines Rather than Areas - Displays a line graph of the measured data. Turning 
this option off turns the area under the measured data black in the plot. 

• Draw Plot Coordinates Only When Ctrl Key is Pressed -  Display the cursor's plot coordinates 
only when the Control key is pressed. The plot coordinates are the elapsed time of the trip and the 
data value associated with that time. If not checked, the cursor's coordinates on the plot are 
displayed continuously when the cursor is within the plot area. 

• Normalize vertical axes to ___ MPH / KPH - Set the upper limit of the vehicle speed plot to the 
speed of your choice. You can change the speed used to normalize the axes by highlighting the 
current speed setting with your cursor and then entering the new speed. If not checked, the upper 
limit of the vertical axes will be the maximum speed achieved by the vehicle during the current trip. 

3. Click OK to save the new plot options. Click Cancel to exit the dialog box and retain the previous 
plot options.  

See Also: 

Draw Speed Bands 

Draw Braking Events 

Draw Acceleration Events 

Draw Plots Using Lines 

Draw Plot Coordinates 

Normalize Vertical Axis 

 

Back to Walkthrough -Full Setup | Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Draw Speed Bands 
The Draw Speed Bands check box in the Setup / Plots dialog box displays the speed limitations set in 
Set Speed Bands dialog box in the plots displayed in the Trip Log Plot view.  

By selecting this option in the Setup/Plots dialog box, the speed bands are drawn in the plot. These 
speed bands are represented in the plot by horizontal dotted lines. The two intermediate speed bands are 
black dotted lines. The maximum speed band is a red dotted line. 

To display speed bands in the plots: 

1. Select Plots from the Setup menu. The Setup / Plots dialog box displays. 

31 



CarChip Online Help Printable Version 

 

2. Click on the Draw Speed Bands check box to toggle the function on and off. A check indicates that 
the Draw Speed Bands function has been enabled. 

3. Click OK to save the new plot setup. Click Cancel to exit the dialog box and retain the previous plot 
setup. Click Apply to make the change without exiting the dialog box. 
  

See Also: 

Speed Band Right-Click Commands 

 

Back to Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Draw Braking Events 
The Draw Braking Events check box in the Setup / Plots dialog box displays any hard and extreme 
braking events in the Trip Log Plot view when selected.  The thresholds for hard and extreme braking are 
set in the Set Braking Thresholds dialog box.  

If the Draw Braking Events box is selected from the Setup / Plots dialog box, the braking events are 
represented by red vertical lines. A hard braking event is a dotted red vertical line.  An extreme braking 
event is a solid red vertical line. 

To display acceleration events in the plots: 

1. Select Plots from the Setup menu. The Setup / Plots dialog box displays. 

 

2. Click the Draw Braking Events check box to toggle the function on and off. A check indicates that 
the Draw Braking Events function has been enabled. 
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3. Click OK to save the new plot setup. Click Cancel to exit the dialog box and retain the previous plot 
setup. Click Apply to make the change without exiting the dialog box. 

 

Back to Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Draw Acceleration Events 
The Draw Acceleration Events check box in the Setup / Plots dialog box displays any hard and 
extreme acceleration events in the Trip Log Plot view when selected.  The thresholds for hard and extreme 
accelerations are set in the Set Acceleration Thresholds dialog box.  

If the Draw Acceleration Events box is selected from the Setup / Plots dialog box, the acceleration 
events are represented by blue vertical lines. A hard acceleration event is a dotted blue vertical line.  An 
extreme acceleration event is a solid blue vertical line. 

To display acceleration events in the plots: 

1. Select Plots from the Setup menu. The Setup / Plots dialog box displays. 

 

2. Click the Draw Acceleration Events check box to toggle the function on and off. A check indicates 
that the Draw Acceleration Events function has been enabled. 

3. Click OK to save the new plot setup. Click Cancel to exit the dialog box and retain the previous plot 
setup. Click Apply to make the change without exiting the dialog box. 

 

Back to Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Draw Plots As Lines 
The Draw Plots As Lines check box in the Setup / Plots dialog box displays the trip and plot 
information in lines in the Trip Log Plot view when selected.   

If the Draw Plots As Lines box is selected from the Setup / Plots dialog box, the plot information is 
displayed as a black line. If the Draw Plots As Lines box is toggled off, the area under the plot line is 
filled black. 

To display lines in the plots: 

1. Select Plots from the Setup menu. The Setup / Plots dialog box displays. 
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2. Click the Draw Plots Using Lines Rather Than Areas check box to toggle the function on and off. 
A check indicates that the Draw Plots Using Lines function has been enabled. 

3. Click OK to save the new plot setup. Click Cancel to exit the dialog box and retain the previous plot 
setup. Click Apply to make the change without exiting the dialog box. 

 

Back to Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Plot Coordinates Options 
The Setup \ Plots dialog box contains the Draw Plot Coordinates Only when Central key Is Pressed 
check box. When selected, the plot coordinates, which include the time and speed of the coordinate 
display when the Control key is pressed with the cursor over a coordinate in the plot. When the check box 
is not selected, the plot coordinates are displayed any time the cursor is active over a plot.  

To display  plots with a normalized axis: 

1. Select Plots from the Setup menu. The Setup / Plots dialog box displays. 

 

2. Click the Draw Plot Coordinates... check box to toggle the function on and off. A check indicates 
that coordinates display only when the Control key is pressed in a plot view. When the function is 
turned off, coordinates are displayed anytime the cursor is active over a plot. 

3. Click OK to save the new plot setup. Click Cancel to exit the dialog box and retain the previous plot 
setup. Click Apply to make the change without exiting the dialog box. 

 

Back to Setup Menu 
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Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Normalize Vertical Speed Axes 
The Normalize Vertical Speed Axes check box in the Setup / Plots dialog box displays the plot vertical 
axis based on a set speed in the Trip Log Plot view when selected.   

If the Normalize Vertical Speed Axes check box is selected from the Setup / Plots dialog box, the top 
limit of the plot is the speed limit displayed in the text box. If this check box is not selected, each plot is 
displayed based on the maximum speed reached in the plot. 

To display  plots with a normalized axis: 

1. Select Plots from the Setup menu. The Setup / Plots dialog box displays. 

 

2. Click the Normalize Vertical Speed Axes check box to toggle the function on and off. A check 
indicates that the plots display normalized speed axis. 

3. Type the speed that represents the top limit displayed in all the Trip Log Plot views.  
 
The default vertical axis value is 90 mph, 153 kph, or 42.5 meters per second, based on the unit 
system selected from the Units dialog box. The maximum allowable vertical axis speed is 158 mph, 
255 kph, or 70.8 m/s. 

4. Click OK to save the new plot setup. Click Cancel to exit the dialog box and retain the previous plot 
setup. Click Apply to make the change without exiting the dialog box. 

 

Back to Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Units of Measure 
You can select the units of measure used by CarChip software to display the CarChip data. You can even 
create custom unit systems. 

Three Unit Systems are included with the CarChip software: 

• U.S. - Displays measurements and units based on the U.S. measurement system. 

• Metric - Displays measurements and units based on the metric system. 

• S.I. - Displays measurements based on the International System of Units.  

To select a measurement system: 

1. Select Units from the Setup menu.  

The Setup / Units dialog box displays. 
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2. Select the desired unit system from the Unit System drop-down box.  

The new unit system selection displays. To see the unit used for every unit type in the selected 
system, click a unit type name from the Unit Type drop-down box. The unit of measure for the 
selected unit type displays in the Units dialog box. 

3. Click OK when you are satisfied with the unit system selection. 

To create a custom measurement system: 

You can define a custom unit system for CarChip if you have specialized units-of-measure requirements. 

1. Select Units from the Setup menu. The Setup / Units dialog box displays. 

2. Click New on the Setup / Units dialog box. The New Unit System dialog box displays. 

 

3. Type the name of the new unit system in the Name box. 

3. Select the unit system the new customized measurement system uses as a template from the 
Based On drop down box. 

4. Click OK to add the new unit system, or click Cancel to exit the dialog box without making any 
changes. The Setup / Units dialog box displays with the customized unit system. 

5. Select a unit type whose value you want to change from the Unit Type drop down box. The 
available units for the unit type display in Units drop down box. 

6. Select the unit you want for each Unit Type in the list. See Unit Type for more information. 

7. Click OK to save and display your unit changes. Click Cancel to exit the Units dialog box without 
saving your changes. 

To select a custom date and time unit: 

1. Select a custom Unit from the Unit System drop down box or create a new one. 

2. Select Date from the Unit Type drop down box. 

3. Select from the following date types; MM/DD/YYYY, DD/MM/YYYY, YYYY/MM/DD 

4. Select Time from the Unit Type drop down box. 

5. Select from the following time formats: AM/PM, 24 hour. 

6. Click OK to save and display your unit changes. Click Cancel to exit the Units dialog box without 
saving your changes. 

To rename a custom unit system: 
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1. Select Units from the Setup menu. The Setup / Units dialog box displays. 

2. Select the custom unit system that you want to rename. 

3. Click Rename on the Setup / Units dialog box. The Rename Unit System dialog box displays. 

 

4. Type the new name for the custom unit system in the Name box. 

5. Click OK to rename the custom unit system, or click Cancel to exit the dialog box without making 
any changes. The Setup / Units dialog box displays with the new custom unit name. 

To delete a custom unit system: 

You can delete any custom unit system you have defined for CarChip. The standard unit systems cannot 
be deleted. 

1. Select Units from the Setup menu. The Setup / Units dialog box displays. 

2. Use the drop-down list to select the custom unit system you want to delete. 

3. Click Delete on the Setup / Units dialog box. The Delete Unit System dialog box displays. 

 

4. Click Yes to delete the selected unit system, or click No to cancel the command. 

Back to Walkthrough - Full Setup | Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

Parameter Thresholds 
Use the Parameter Thresholds dialog box to set monitors on your vehicle's activities.  

Note: This dialog box in the Setup Menu is for advanced CarChip data logger models, E/X for higher. The 
dialog box can be accessed from the Setup menu for basic CarChip models, but any parameter changes 
made are not recorded by the basic CarChip model. 

The Parameter Thresholds dialog box allows you to set thresholds for multiple areas of your vehicle. The 
information that is downloaded from the data logger based on these selected thresholds displays in the 
Summary Log view in the View menu. 
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To set parameter thresholds: 

1. Select Parameter Thresholds from the Setup Menu. The Parameter Thresholds dialog box 
displays. 

2. Set the maximum threshold for each parameter.  
 
The maximum threshold is the value that a vehicle can safely work under for each parameter. The 
thresholds should be set based on your vehicle's specifications. Consult your vehicle's owner's 
manual for safe limitations of these parameters. See Vehicle Data Parameters for the list of data 
parameters you can monitor. 

3. Click OK to save your parameter threshold changes, click Cancel to exit the dialog box without 
saving your changes or click Default to display the default parameter threshold values. 

 

Back to Walkthrough -Full Setup | Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Vehicle Data Parameters 
There are several data parameters that you can configure your CarChip data logger to monitor by using 
the Parameter Thresholds and Choose Other Parameters dialog boxes. The data parameters that you 
select are displayed in the Summary Log, and the Trip Plot and Table Views. The data parameters that are 
available are: 

• Vehicle Speed 
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• Engine Speed 

• Throttle Position 

• Coolant Temperature 

• Engine Load 

• Intake Manifold Pressure 

• Air Flow Rate 

• Intake Air Temperature 

• Timing Advance 

• Fuel Pressure 

• Fuel System Status 

• Short Term Fuel Trim (B1) 

• Short Term Fuel Trim (B2) 

• Long Term Fuel Trim (B1) 

• Long Term Fuel Trim (B2) 

• O2 Sensor Voltage (B1, S1) 

• O2 Sensor Voltage (B1, S2) 

• O2 Sensor Voltage (B1, S3) 

• O2 Sensor Voltage (B1, S4) 

• O2 Sensor Voltage (B2, S1) 

• O2 Sensor Voltage (B2, S2) 

• O2 Sensor Voltage (B2, S3) 

• O2 Sensor Voltage (B2, S4) 

• Battery Voltage 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Driver ID 

Driver ID 
The Driver ID dialog box lets you configure the drivers that have logged trips on the CarChip data logger. 
You can add, delete, and edit Driver IDs. The Driver IDs are used to associate a driver with trip 
information. 

To view all the Driver IDs: 

1. Select Driver ID from the Setup Menu. 
 
The Driver ID dialog box displays with a list of the available Driver IDs.  
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2. Scroll the list of Driver IDs using the scroll bar. 

To create a new driver, from the Driver ID dialog box:  

1. Click Add.  
 
The New Driver dialog box displays. 

 

2. Enter a unique driver name or ID in the ID box. 

3. Enter a name in the Name box and click OK. 
 
You do not have to enter a name in the name box. Click OK if you want the information displayed in 
the ID box to display in the Name box. The new driver information displays in the Driver ID table.  

4. Click OK to add the Driver ID, or click Cancel to exit the Driver ID dialog box without saving 
changes.  

To delete an existing driver, from the Driver ID dialog box:  

1. Select a driver name from the Driver ID table. 

2. Click Delete. The selected driver ID is deleted from the list. 

3. Click OK to delete the Driver ID, or click Cancel to exit the Driver ID dialog box without saving 
changes.  

To edit existing driver information, from the Driver ID dialog box: 

1. Double-click the Name field for the driver name you want to change.  
 
The selected driver name is highlighted. 

2. Edit the driver name. 

3. Click OK to accept the changes to the Driver ID, or click Cancel to exit the Driver ID dialog box 
without saving changes.  

Note: You can not edit the ID field for the Driver IDs. If you would like to change the Driver ID of an 
existing driver, delete the driver ID and add a new driver ID.  

Back to Walkthrough- Full Setup | Setup Menu 

   
Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 
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Driver ID Column 
Each driver in the CarChip database is primarily identified by a driver ID. Once a Driver ID has been 
created, it can not be renamed or edited.  

 

 

See Also: 

Driver ID 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Driver ID Name Column 
Each driver in the CarChip data base is identified by a driver ID and name. The Driver Name column in the 
Driver ID dialog box displays the unique name given to the driver. Click name column for a driver to 
rename or edit the driver name field. 

 

 

 

See Also: 

Driver ID 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Vehicle ID 

Vehicle ID 
The Vehicle ID dialog box lets you configure the vehicles that the CarChip data logger has been 
connected to. You can add, delete, and edit Vehicle IDs. The Vehicle IDs are used to associate a vehicle 
with trip information. 

To view all the Vehicle ID's: 
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1. Select Vehicle ID from the Setup Menu. 
 
The Vehicle ID dialog box displays with a list of the available Vehicle IDs.  

 

2. Scroll the list of Vehicle IDs using the scroll bar. 

To create a new vehicle:  

1. Click Add from the Vehicle ID dialog box.  
 
The New Vehicle dialog box displays. 

 

2. Enter a unique vehicle name or the vehicle's VIN number in the VIN box. 

3. Enter a unique vehicle name in the Name box and click OK. 
 
You do not have to enter a name in the name box. Click OK if you want the information displayed in 
the VIN box to display in the Name box. The new vehicle information displays in the Vehicle ID 
table.  

4. Click OK to add the Vehicle ID, or click Cancel to exit the Vehicle ID dialog box without saving 
changes.  

To delete an existing vehicle: 

1. Select a vehicle name from the Vehicle ID table from the Vehicle ID dialog box. 

2. Click Delete. The selected vehicle ID is deleted from the table. 

3. Click OK to delete the Vehicle ID, or click Cancel to exit the Vehicle ID dialog box without saving 
changes.  

To edit existing vehicle information: 

1. Double-click the Name field  from the Vehicle ID dialog box, 
 
The selected vehicle name is highlighted. 

2. Edit the vehicle name. 

3. Click OK to accept the changes to the vehicle ID, or click Cancel to exit the Vehicle ID dialog box 
without saving changes.  

Note: You can not edit the VIN field for the Vehicle ID's. If you would like to change the Vehicle ID of an 
existing driver, delete the vehicle ID and add a new vehicle ID.  

Back to Walkthrough - Full Setup | Setup Menu 
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Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Vehicle ID Name Column 
Each vehicle in the CarChip database is primarily identified by the vehicle identification number (VIN). In 
some cases your CarChip will be able to read the VIN via the OBDII port, but not all manufacturers have 
implemented this feature. In most cases you will need to manually enter a VIN number for each vehicle, 
or other number by which you can uniquely identify each vehicle. In addition to the VIN, you can also give 
each vehicle a name which will be used to identify the vehicle in reports. 

 

See Also: 

Vehicle ID 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Vehicle ID VIN Column 
Each vehicle in the CarChip data base is primarily identified by the vehicle identification number (VIN). In 
some cases your CarChip will be able to read the VIN via the OBDII port, but not all manufacturers have 
implemented this feature. In most cases you will need to manually enter a VIN number for each vehicle, 
or other number by which you can uniquely identify each vehicle. In addition to the VIN, you can also give 
each vehicle a name which will be used to identify the vehicle in reports. 

 

See Also: 

Vehicle ID 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 
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CarChip ID 

CarChip ID 
The CarChip ID dialog box displays information about the CarChip data logger or loggers you are using, 
including serial numbers, the CarChip data loggers with data that the CarChip software is currently using, 
and the CarChip name.  Use the CarChip ID dialog box to enter, edit, or delete a CarChip data logger 
name.  

To view all the CarChip IDs: 

1. Select CarChip ID from the Setup Menu. 
 
The Setup / CarChip ID dialog box displays with a list of the available CarChip IDs.  

 

2. Scroll the list of CarChip IDs using the scroll bar. 

To edit existing CarChip information: 

1. Double-click the Name field for a CarChip data logger from the CarChip ID dialog box.  
 
The selected CarChip name is highlighted. 

2. Edit the CarChip name. 

3. Click OK to accept the changes to the Driver ID, or click Cancel to exit the Driver ID dialog box 
without saving changes.  

 

Back to Walkthrough - Full Setup  | Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

CarChip Name Column 
The CarChip Name Column lets you give each CarChip data logger that has been connected to the CarChip 
software a name which is used to identify the CarChip in the different reports available in the View menu. 
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See Also: 

CarChip ID 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

CarChip Serial Number Column 
The CarChip Serial Number Column displays the unique CarChip data logger serial number assigned to 
each CarChip that has been connected to the CarChip software. The serial number is embedded in the 
CarChip, and cannot be changed. 

 

See Also: 

CarChip ID 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Miscellaneous 
The Miscellaneous dialog box lets you configure the memory clearing options for the CarChip data 
logger.  

To configure the CarChip memory clear options: 

1. Select Miscellaneous from the Setup menu. The Setup / Miscellaneous dialog box displays. 

 

2. Select one of the following options from the drop-down box: 

• Always - The CarChip data logger memory is automatically cleared after each download. 

• Never - The CarChip's memory is not cleared after every download and you will not be prompted if 
you want to clear the memory. Use the Clear CarChip Memory command from the CarChip menu to 
clear the memory manually. 

• Ask - The software asks you after each download if you want to clear the CarChip data logger 
memory. 

3. Click OK to save the selected memory clearing option. Click Cancel to exit the dialog box and retain 
the previous selection. Click Apply to make the change without exiting the Miscellaneous dialog 
box. 
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Back to Walkthrough - Full Setup | Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

Miscellaneous Command: Clear Memory Box 
The Clear Memory box in the Miscellaneous dialog box contains memory clearing options for the CarChip 
data logger.  

To configure the CarChip memory clear options: 

1. Select Miscellaneous from the Setup menu. The Setup / Miscellaneous dialog box displays. 

 

2. Select one of the following options from the drop-down box: 

• Always - The CarChip data logger memory is automatically cleared after each download. 

• Never - The CarChip's memory is not cleared after every download. Use the Clear CarChip 
Memory command from the CarChip menu to clear the memory manually. 

• Ask - The software asks after each download if you want to clear the CarChip data logger 
memory. 

3. Click OK to save the selected memory clearing option. Click Cancel to exit the dialog box and retain 
the previous selection. Click Apply to make the change without exiting the Miscellaneous dialog 
box. 

 

 Back to Setup Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Clear CarChip Memory? 
The Question \ Clear CarChip Memory dialog box displays after every download if, the Ask option is the 
current memory clearing option selected from the Miscellaneous dialog box from the Setup menu.  

To Clear the CarChip data logger's memory: 

1. Click Yes. 

To keep the current data on the CarChip data logger: 

1. Click No. 

To hide this dialog box in future downloads: 

1. Click Don't Ask Again and your desired memory clearing option. 

Note: This dialog box contains a Don't Ask Again check box. By Checking this option and clicking Yes, 
the CarChip's memory is automatically cleared after every download. By clicking No, the CarChip's 
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memory is never cleared after download. To change your CarChip memory clearing options, see Clear 
Memory. 

 

See Also: 

Setup / Miscellaneous 

 

Back to  Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

CarChip Menu Commands 

CarChip Menu Commands 
The CarChip menu commands control operations affecting the CarChip data logger.  

Note: The data logger must be connected to your computer to access any of these commands.  

The commands that display in this menu depend on the CarChip data logger model. The CarChip menu 
commands are: 

Download CarChip Data - Lets you download data from the CarChip data logger to your computer. 

Display CarChip Memory - Displays the available memory available on your CarChip data logger. 

Clear CarChip Memory - Lets you clear the CarChip memory. 

Enable CarChip LED - Controls the modes of operation for your CarChip LED. 

Reset Check Engine Light - Configures your CarChip to turn off the Check Engine Light in your vehicle. 

Enable CarChip Alarm - Controls the modes of operation for your CarChip Alarm. 

Note: This command is only available for the CarChip Pro (# 8226), CarChip Fleet Pro (# 8246), and 
CarChip E/X Alarm (product 8225), and CarChip Fleet with Alarm (# 8245) model. 

Enable CarChip VIN Mode - Configures your CarChip to retrieve vehicle's unique VIN number when it is 
connected to a car. 

Note: This command is only available for CarChip models 8211, 8221, 8225, 8226, 8241, 8245, and 8246. 

Set Anomalous Vehicle - Lets you configure your CarChip data logger to meet any unique specifications 
present on the ODBII port of your vehicle. 

Set Speed Bands - Lets you set speed thresholds so you can monitor your speed. 

Set Braking Thresholds - Lets you configure the deceleration rates that determine hard and extreme 
breaking in your vehicle. 

Set Acceleration Thresholds -  Lets you configure the acceleration rates that determine hard and extreme 
acceleration in your vehicle. 

Set Clock - Lets you set the CarChip data logger's internal clock to your computer's clock. 

Choose Other Parameters - Lets you configure parameters regarding your 

 

Back to Home 
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Home | File | Setup | CarChip | View | Help | Shortcuts 

Downloading CarChip Data 
Once you have connected your CarChip data logger to your computer, you are ready to download data 
from any of the CarChip models.   

To download data: 

1. Click the Download CarChip icon or select Download CarChip Data from the CarChip menu.  
 
In some instances, the Warning Clock Setup dialog box displays. When data is downloaded, the 
software automatically compares the internal clock on the CarChip against the clock on your 
computer. Click OK to continue or check Synchronize Clocks to set the CarChip data logger's 
internal clock to your computer's clock. 
 
The Downloading Logs status dialog box displays. Click Cancel to abort the download before it is 
finished. The Downloading Logs dialog box closes when the download is complete. 

 

2. The Question dialog box displays. The Question dialog box asks if you want to delete the data 
currently in the CarChip memory. 

 

3. Click No to keep the current data in the CarChip device, or click Yes to clear the CarChip memory. 

Note: This dialog box contains a Don't Ask Again check box. By Checking this option and clicking Yes, 
the CarChip's memory is automatically cleared after every download. By clicking No, the CarChip's 
memory is never cleared after download. To change your CarChip memory clearing options, see Memory 
Clearing Options. 

The Unidentified Vehicle/Driver dialog box displays. See Unidentified Vehicle/Driver ID for more 
information on this dialog box.  

Once you have finished associating vehicles and drivers with the downloaded trip data, the Activity Log 
Summary view automatically displays the downloaded data. 

 

Back to CarChip Menu | Getting Started 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

Display CarChip Memory 
The Display CarChip Memory dialog box displays how much memory is currently be used by the CarChip 
data logger. 

Note: This command is only available when a CarChip data logger is connected to your computer. 
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To display CarChip memory information: 

1. Select Display CarChip Memory from the CarChip menu. The Display CarChip Memory dialog box 
displays the following information  
 
Used - The memory occupied by data. 
 
Free - The amount of memory available for data. 
 
Total - The  total amount of memory available on the data logger. 
  

 

2. Click OK to close the dialog box. 

The amount of memory available on the CarChip depends on the Carchip Model. See CarChip Pro and 
CarChip Fleet Pro Specifications for information on the memory size available for the CarChip Pro and 
CarChip Fleet Pro models. See CarChip, CarChip E/X, and CarChip E/X with Alarm for information on 
memory size of older models of Carchip. 

 

Back to CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Clear CarChip Memory 
The Clear CarChip Memory dialog box lets you clear the CarChip data logger's memory. 

To clear CarChip memory: 

1. Select Clear CarChip Memory from the CarChip menu. The Clear CarChip Memory dialog box 
displays. 

 

2. Click Yes to clear the CarChip data logger memory. Click No to exit the dialog without clearing the 
data logger memory. 

 

Back to CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Enable CarChip LED 
The Enable CarChip LED command on the CarChip menu toggles the CarChip LED between Diagnostic 
Mode and Disabled Mode. When a check box displays next to the Enable CarChip LED command, the 
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Diagnostic Mode is in use on the CarChip data logger. If a check box does not display, the CarChip data 
Logger LED is in Disabled Mode. 

To toggle between the CarChip LED modes: 

1. Select Enable CarChip LED from the CarChip menu.  
 
The CarChip software takes a moment to initialize the LED setting. The CarChip LED is now in 
Diagnostic Mode.  

2. Select Enable CarChip LED a second time.  
 
The CarChip software take a moment to initialize the LED setting. The CarChip LED is now in Disabled 
Mode. 

To view CarChip LED status: 

1. View Enable CarChip LED from the CarChip menu.  
 
If a check displays next to the command, Diagnostic Mode is currently in use on your CarChip. If a 
check does not display, Disabled Mode is currently in use. 

See Also: 

CarChip LED Modes 

 

Back to CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

CarChip LED Modes 
The CarChip can be toggled between two LED Modes: Diagnostic and Disabled. 

Diagnostic Mode 

Diagnostic Mode enables the LED in the following manner: 

Self-test Mode - Displays three rapid blinks, indicating the initial hardware self-test was completed 
successfully. 

Communications Mode - Displays two rapid blinks per second until the CarChip successfully begins to 
communicate with a vehicle. 

Data Mode - Displays one blink per second while the CarChip is communicating with a vehicle. 

Sleep Mode - Does not display any blinks. 

PC Mode - Displays one blink per second whenever CarChip is connected to a PC. LED is 100% ON when 
downloading to a PC. 

Disabled Mode 

When the CarChip LED is disabled only the Self-test and PC modes are active. 

Self-test Mode - Displays three rapid blinks indicates the initial hardware self-test was completed 
successfully. 

PC Mode - Displays one blink per second whenever CarChip is connected to a PC. LED is 100% ON when 
downloading to a PC. 

 

Back to CarChip Menu | Enable CarChip LED 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 
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Reset Check Engine Light 
The Reset Check Engine Light command enables your CarChip data logger to turn off the Check Engine 
light in your vehicle the next time the CarChip data logger is connected to your vehicle. 

Note: If the condition that caused the check engine light to appear has not been corrected, the light will 
reappear the next time the car detects the condition. 

To turn the Reset Check Engine Light command on and off: 

1. Select Reset Check Engine Light from the CarChip menu.  
 
The CarChip software takes a moment to initialize the setting. The Reset Check Engine Light is now 
turned on.  

2. Select Reset Check Engine Light a second time.  
 
The CarChip software take a moment to initialize the setting. The Reset Check Engine Light is now 
turned off. 

To view Reset Check Engine Light status: 

1. View the Reset Check Engine Light command from the CarChip menu.  
 
If a check displays next to the command, the command is turned on. If a check does not display, the 
command has been turned off. 

 

Back to CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Enable CarChip Alarm 
The Enable CarChip Alarm command is active (not grayed out) on the CarChip menu when a CarChip E/X 
with Alarm (# 8225), CarChip Fleet with Alarm (# 8245), CarChip Pro (# 8226) or CarChip Fleet Pro (# 
8246) is connected to your computer and has an established a connection with the CarChip software. 
These models of CarChip emit an audible alarm in your vehicle when speed band thresholds, acceleration 
and braking thresholds have been exceeded.  

The Enable Alarm command initializes the alarm setting and allows you to set the alarm volume or 
disable the alarm if the alarm is currently enabled through the Set Alarm dialog box. When a check box 
displays next to the Enable Alarm in the CarChip Menu, the alarm on the CarChip data logger is turned 
on. If a check box does not display, the CarChip data logger alarm has been turned off.  

To toggle the CarChip Alarm on and off: 

1. Select Enable Alarm from the CarChip menu.  
 
The CarChip software takes a moment to initialize the Alarm setting. The Set Alarm dialog box 
displays with the alarm settings available for the version of CarChip you are using. See Set Alarm 
Volume for more information.  

To view CarChip Alarm Status: 

1. View Enable Alarm from the CarChip menu.  
 
If a check displays next to the command, the CarChip alarm is turned on and in use. If a check does 
not display,  the CarChip alarm is turned off. 

 

Back to CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 
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Set Alarm Volume 
The Set Alarm Volume dialog box allows you to enable and set the alarm volume on the CarChip Pro (# 
8226) and Carchip Fleet Pro (# 8246) or allows you to enable the alarm for all other models of CarChip. 
The command is available on the CarChip menu when a CarChip E/X with Alarm (# 8225), CarChip Fleet 
with Alarm (# 8245), CarChip Pro (# 8226) or CarChip Fleet Pro (# 8246) is connected to your computer 
and has an established a connection with the CarChip software.  These models of CarChip emit an audible 
alarm in your vehicle when speed band thresholds, acceleration and braking thresholds have been 
exceeded.  

To enable or set alarm volume: 

1. Select Enable Alarm from the CarChip menu.  
 
The CarChip software takes a moment to initialize the Alarm setting. The Set Alarm dialog box 
displays with the CarChip's current Alarm status and the options available for the alarm.  
 
If a CarChip Pro or Carchip Fleet Pro is connected, the Set Alarm dialog box displays the High, 
Medium, and Low radio button options and the Disabled radio button for disabling the CarChip's 
Alarm. If an older model CarChip is connected, the Medium radio button or Disabled radio button 
are the only selections available in the Set Alarm dialog box.  

 

 

2. Select an available volume option or Disabled and click OK to save the alarm settings or Cancel to 
exit the dialog box without saving. 
 
The CarChip software take a moment to initialize the alarm setting. The CarChip Alarm is now off. 

 

Back to CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Enable CarChip VIN Mode 
The Enable CarChip VIN mode command on the CarChip menu toggles the VIN reading function on the 
CarChip data logger on and off. When the CarChip VIN mode is turned on, the CarChip data logger reads 
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the unique VIN number associated with the vehicle the next time the CarChip data logger is connected to 
the vehicle. When the trip information is later downloaded, the VIN number is associated with trips taken, 
and displays in the Trip Log Report View.  When the CarChip VIN mode is turned off,  the VIN number is 
not recorded and does not display in association with trip information.  

Caution: With VIN Mode enabled, the CarChip records the VIN number from the vehicle if the 
vehicle supports that feature.  If the VIN number does not display the next time the CarChip 
has been connected to your vehicle, we recommend you disable the CarChip VIN Mode, since 
asking for data the vehicle does not support can cause undesirable side effects. 

The Enable VIN Mode command toggles the VIN mode on and off. When a check box displays next to the 
Enable VIN Mode command, the VIN recording capabilities on the CarChip data logger are turned on. If a 
check box does not display, the CarChip data logger alarm has been turned off.  

Note: The Enable VIN Mode command is not available for the serial versions (# 8210, 8220) of CarChip. 

To toggle the CarChip VIN Mode on and off: 

1. Select Enable VIN Mode from the CarChip menu.  
 
The CarChip software takes a moment to initialize the VIN setting. The CarChip VIN mode is now on 
and will record the VIN information on a vehicle the next time it is connected to a vehicle.  

2. Select Enable VIN Mode a second time.  
 
The CarChip software take a moment to initialize the VIN setting. The CarChip VIN mode is now off. 

To view CarChip VIN status: 

1. View Enable VIN Mode from the CarChip menu.  
 
If a check displays next to the command, the CarChip VIN Mode has been enabled on the CarChip 
data logger. If a check does not display, the CarChip VIN Mode is turned off. 

 

Back to CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Set Speed Bands 

Set Speed Bands 
Use the Set Speed Bands dialog box to enter the threshold speeds for the CarChip data logger. The 
threshold speeds help you identify how much time is spent in each speed band. The time spent in each 
band shows up on the Trip Report and the thresholds are displayed as horizontal dotted lines in the Trip 
Speed Plot. 

To set speed bands: 

1. Select Set Speed Bands... from the CarChip menu. The CarChip / Set Speed Bands dialog box 
displays. 
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2. Enter the maximum threshold speed for each of the first three speed bands. The fourth speed band 
consists of all speeds greater than the last threshold, or click Default to use the software default 
threshold settings.  

3. Click OK to save the new speed band settings. Click Cancel to exit the dialog box without saving 
changes to the settings. 

Note: The speed threshold displayed in the fourth speed band is also the threshold that triggers the 
audible alarm in the CarChip Pro, CarChip Fleet Pro, CarChip E/X with Alarm, and CarChip Fleet with Alarm 
models. When this speed band is exceeded in a vehicle, the alarm sounds until the vehicle is no longer 
over the speed band threshold. See Enable CarChip Alarm for more information on using the CarChip 
Alarm feature.  

 

Back to Walkthrough - Full Setup | CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Speed Bands Right-Click Menu 
The Draw Speed Bands check box in the Setup / Plots dialog box contain a right-click menu with 
options regarding the options available for each check box. Using the mouse right-click when the cursor is 
in the Draw Speed Bands edit box displays the following menu choices: 

• Requirements... Ctrl+R 

• Errors...            Ctrl+E 

• Unit Systems...  Ctrl+U 

• Help                 F1 

 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Set Braking Thresholds 

Set Braking Thresholds 
Use the Set Braking Thresholds dialog box to enter the rates of deceleration that define hard braking 
and extreme braking. Accident Logs are created based on the thresholds set in this dialog box. Any time 
the car's braking threshold exceeds these set limits, the event is logged in the Trip Report. 

To set braking thresholds: 
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1. Select Set Braking Thresholds from the CarChip menu. The CarChip / Set Braking Thresholds dialog 
box displays. 

 

2. Enter your desired hard and extreme braking thresholds or click Default to use the software default 
threshold settings. The default braking thresholds are: 0.35 and 0.50 G (US & Metric) and 3.4 and 
4.9 m/s2  (S.I.). 

3. Click OK to save the new settings. Click Cancel to exit the dialog box and retain the previous 
settings. 

Note: The extreme braking threshold is also the threshold that triggers the audible alarm on the CarChip 
Pro, CarChip Fleet Pro, CarChip E/X with Alarm, and CarChip Fleet with Alarm models. When this braking 
threshold is exceeded in a vehicle, the alarm sounds five times. See Enable CarChip Alarm for more 
information on using the CarChip Alarm feature.  

See Also: 

Hard Braking Threshold 

Extreme Braking Threshold 

 

Back to Walkthrough - Full Setup | CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Hard Braking Threshold 
The Hard Braking Threshold box in the Set Braking Thresholds dialog box is the lower of two braking 
thresholds in the CarChip Software.  

The default hard braking threshold for each standard measurement system is: 

• 0.35 G - For U.S. measurement system. 

• 0.35 G - For Metric measurement system. 

• 3.4 m/s2 - For S.I. measurement system.  

See Also: 

Extreme Braking Threshold 

 

Back to Set Braking Thresholds 

   
Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

55 



CarChip Online Help Printable Version 

Extreme Braking Threshold 
The Extreme Braking Threshold box in the Set Braking Thresholds dialog box is the higher of two 
braking thresholds in the CarChip software.  

The default extreme braking threshold for each standard measurement system is: 

• 0.50 G - For U.S. measurement system. 

• 0.50 G - For Metric measurement system. 

• 4.9 m/s2 - For S.I. measurement system.  

 

See Also: 

Hard Braking Threshold 

 

Back to Set Braking Thresholds 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Set Acceleration Thresholds 

Set Acceleration Thresholds 
Use the Set Accelerations Thresholds dialog box to enter the rates of acceleration that define hard 
acceleration and extreme acceleration. These thresholds help you monitor how hard the vehicle is being 
accelerated. Any time the car's acceleration exceeds these set limits, the event is logged in the Trip 
Report. 

To set acceleration thresholds: 

1. Select Set Acceleration Thresholds... from the CarChip menu. The CarChip / Set Acceleration 
Thresholds dialog box displays. 

 

2. Enter your desired hard and extreme acceleration thresholds or click Default to use the software 
default threshold settings. The Default acceleration thresholds are: 0.30 and 0.45 G (US & Metric) 
and 2.9 and 4.4 m/s2  (S.I.). 

3. Click OK to save the new settings. Click Cancel to exit the dialog box and retain the previous 
settings. 

Note: The extreme acceleration threshold is also the threshold that triggers the audible alarm on the 
CarChip Pro, CarChip Fleet Pro, CarChip E/X with Alarm, and CarChip Fleet with Alarm models. When this 
acceleration threshold is exceeded in a vehicle, the alarm sounds five times. See Enable CarChip Alarm for 
more information on using the CarChip Alarm feature.  

See Also: 

Hard Acceleration Threshold 

Extreme Acceleration Threshold 

 

56 



Welcome to CarChip 

Back to Walkthrough - Full Setup | CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Hard Acceleration Threshold 
The Hard Acceleration Threshold box in the Set Acceleration Thresholds dialog box is the lower of two 
acceleration thresholds in CarChip software.  

The default hard acceleration threshold is: 

• 0.30 G - For U.S. measurement system. 

• 0.30 G - For Metric measurement system. 

• 2.9 m/s2 - For S.I. measurement system.  

 

See Also: 

Extreme Acceleration Threshold 

 

Back to Set Acceleration Thresholds 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Extreme Acceleration Threshold 
The Extreme Acceleration Threshold box in the Set Acceleration Thresholds dialog box is the higher of two 
acceleration thresholds in the CarChip software.   

The default extreme acceleration threshold is: 

• 0.45 G - For U.S. measurement system. 

• 0.45 G - For Metric measurement system. 

• 4.4 m/s2 - For S.I. measurement system.  

See Also: 

Hard Acceleration Threshold 

 

Back to Set Acceleration Thresholds 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Set Clock 
The Set Clock dialog box lets you set the CarChip data logger's internal clock to match your computer's 
clock. 

To set the CarChip's internal clock: 

1. Select Set Clock from the CarChip menu. The CarChip / Set Clock dialog box displays. 
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2. Click Yes to set the clock on the CarChip to match the clock on your computer, or click No to exit the 
dialog box and retain the CarChip's previous clock settings. 

 

Back to Walkthrough - Express Setup | Walkthrough - Full Setup | CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Time Difference Adjustment 
When data is downloaded, the software automatically compares the internal clock on the CarChip data 
logger against the clock on your computer. The data that has been downloaded can display the time 
recorded from the CarChip data logger or can adjust to display the times according to your computer. 

To display time recordings based on your computer's clock: 

1. Select Computer from the drop down box when the Time Difference dialog box displays. 
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2. Click OK to download data, or click Cancel to abort the CarChip download. 

To display time recordings based on the CarChip data logger's internal clock: 

1. Select CarChip from the drop down box when the Time Difference dialog box displays. 

2. Click OK to download data, or click Cancel to abort the CarChip download. 

To synchronize clocks (set the CarChip clock to the computer clock): 

1. Click the Synchronize Clocks check box. 

2. Click OK to download data, or click Cancel to abort the CarChip download. 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

 

 

 

Time Difference Warning 
The Warning Clock Setup dialog box displays if the software finds a difference between the internal clock 
on the CarChip and the clock on your computer. See Time Difference Adjustment for more information on 
clock differences. 

 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

 

 

 

Choose Other Parameters 
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Use the Choose Other Parameters dialog box to select up to four additional vehicle data parameters to 
be logged in addition to vehicle speed and allows you to choose the sampling intervals for the parameters.  

To choose other parameters: 

1. Select Choose Other Parameters... from the CarChip menu. The CarChip / Choose Other Parameters 
dialog box displays.  

 

 

(This is the CarChip / Choose Other Parameters dialog box that displays for CarChips with 
firmware 2.18 or later. The Sampling Interval for the Vehicle Speed Parameter is selectable.) 

 

 

 

(This is the CarChip / Choose Other Parameters dialog box that displays for CarChips with 
firmware 2.17 or earlier. The Sampling Interval for the Vehicle Speed Parameter is not 

selectable.) 

 

2. Use the drop down list to select up to four additional vehicle data parameters.  

3. For each parameter including the Vehicle Speed Parameter, select a sampling interval. Note that the 
sampling interval for Vehicle speed is not selectable for CarChips with firmware versions 2.17 or 
earlier but is selectable for CarChips with firmware versions 2.18 or later. To check your CarChip's 
firmware versions, select About CarChip from the Help menu while the CarChip is connected to 
your computer. The CarChip's firmware version displays.  

4. Click OK to save the parameter settings, or click Cancel to exit the dialog box and retain the 
previous settings. 
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Note: A parameter can not be logged more than once. Please review your parameter selections and 
remove any duplicate selections. 

See also: 

List Of Data Parameters 

Sampling Interval 

 

Back to Walkthrough - Full Setup | CarChip Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

 

 

Tools Menu Commands 

Tools Menu Commands 
The Tools menu contains various commands for organizing and categorizing the trip data downloaded 
from your CarChip, such as fuel entry and viewing readiness code records. The Tools menu commands 
are: 

Fuel Entry - Lets you enter fuel usage for each vehicle associated with the CarChip software. 

Emissions Readiness - Displays all the records for the readiness code tests a vehicle performs at startup 
and the resulting status of those tests. 

Trip Type Entry - Lets you select and categorize trips by type and creates a mileage analysis based on the 
categorized trips. 

 

Back to Home 

 

Home | File | Setup | CarChip | View | Help | Shortcuts 

Fuel Entry 
The Fuel Entry dialog box lets you enter information about fuel usage and costs for every vehicle you have 
added to the CarChip software. Fuel entry information is used to calculate the fuel efficiency and fuel 
expense and is displayed in the CarChip Home Page and Vehicle Summary View. 

To add a fuel entry: 

1. Select Fuel Entry from the Tools menu. The Fuel Entry dialog box displays. 
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2. Select the vehicle from the Vehicle box. 

3. Select the date the fuel was purchased from the Date box. 

4. Enter the amount of fuel purchased in the Amount box. 

5. Enter the price paid for the fuel purchase in the Bill box. 

6. Click OK to close the Fuel Entry dialog box without saving the fuel entry information, or click Save 
to save the fuel entry information. Select a date from the Fuel Entry list box and click Delete to 
delete fuel entries.  

 

Back to Tools Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Emissions Readiness 
The Emissions Readiness dialog box displays the last recorded status of the emissions readiness codes 
for every vehicle in the CarChip Database. Use this dialog box to view whether or not a particular 
readiness code is supported for the vehicle and whether or not the monitor completed its test for each of 
the available readiness codes. A readiness code is used to indicate whether or not monitored emissions 
control systems have been tested by the OBDII system. Each emissions control system has its own 
monitor and related code. Some emission control components are tested continuously throughout a trip 
and others are tested intermittently when predetermined operating conditions are met.  

Note: The readiness code database displays readiness codes from the last recorded trip for every CarChip 
and assigned vehicle in the database. One readiness code record is available for each assigned vehicle. 

To organize trip type information: 

1. Select Emissions Readiness from the Tools menu.  The Readiness Code dialog box is displayed. 
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2. Select a Vehicle from the Vehicle drop-down box. 
 
The Readiness Code dialog box displays the eleven possible readiness codes, whether or not the 
readiness code is supported for the vehicle and if the monitor completed a test or did not complete a 
test of its systems at the time the codes were recorded (usually at time of vehicle start-up) for each 
of the available readiness codes for the selected vehicle.  
 
The readiness codes monitored are: 
 
Catalyst 
Heated Catalyst 
Evaporative System 
Secondary Air System 
A/C System Refrigerant 
Oxygen Sensor 
Oxygen Sensor Heater 
EGR System 
Misfire 
Fuel System 
Comprehensive Component 
 
Not all eleven monitors displayed on the list may be supported, or monitored by your vehicle's 
systems. If "Not Supported" displays in the supported column, it simply means that the monitor does 
not exist or is not monitored by your vehicle. See your vehicle's manual or supporting documentation 
for emission monitors that your vehicle does support.  
 
The Status column displays "Complete" or "Not Complete" for the readiness codes that are supported 
in your vehicle and "--" for all the readiness codes that are not supported. A "Complete" means a test 
of that emissions monitor was completed at the time of CarChip recorded the readiness codes. A "Not 
Complete" could mean that the OBD system has not yet completed testing of that component or 
system or that a component failure may exist, but has not been identified because system testing 
has not been complete. Most states allow for two "Not Complete" readiness codes during OBD or 
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smog check testing. If three or more "Not Complete", non-continuous codes are present, the vehicle 
may be deemed as "Unable to complete OBD Testing". See your state's rules and regulations for 
more details. 

3. Click OK to exit. 

Back to Tools Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Trip Type Entry 
The Trip Type Entry dialog box lets you categorize the all the recorded trips by trip type and provides a 
mileage analysis of the types of trips taken. The trip information is displayed in summary report. 

To organize trip type information: 

1. Select Trip Type Entry from the Tools menu. The Trip Type Entry dialog box displays. 

 

2. Select the a driver from the Driver box or select All. 

3. Select a vehicle from the Vehicle box or select All. 

4. Select the Search All Dates check box or enter a date range for the trips you want displayed in the 
Date Range __ To __ box. Selecting a date range is especially helpful if you do not want to display 
all the trip entries or if you want to limit the number of trips displayed based on the last download.  

5. Select a trip type for each trip listed in the Trip Box. There are four trip types to choose from: 
"Business", "Personal", "Commute", "Other". "Other" is the default setting for all the trips listed. 

6. Click View Data. The triptype.txt file opens up in a text editor, displaying a mileage summary for the 
vehicle and driver you selected, between the date ranges you selected. If you wish to save this 
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mileage summary, save the file under a different name. Every time new trip type information is 
added, the triptype.txt file is reopened displaying the new summary, which means the previous data 
is no longer present. 

7. Close the file and return to the dialog box.  

8. Click OK to close the Trip Type Entry dialog box. 

 

Back to Tools Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

View Menu Commands 

View Menu Commands 
The View menu commands allow you to view Trip Log, Activity Log, Accident Log, Vehicle Trouble Log and 
Summary Log information. 

Note: The Accident and Summary Log menu commands are only available for CarChip data logger model 
E/X or higher.  

Use the following topics to learn more about each log view: 

CarChip Home Page 

Trip Log 

Activity Log 

Accident Log 

Vehicle Trouble Log 

Summary Log 

 

Back to Home | Getting Started 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

CarChip Home Page 
The CarChip Home Page displays summary information about the CarChip data loggers, vehicle IDs, and 
driver IDs listed in the CarChip software. From the Home Page you can access the monthly vehicle and 
driver summaries as well as detailed monthly summaries for every vehicle and driver listed in the home 
page. 

To view the Home Page: 

1. Click on the Home icon or select Home from the View menu. The Home Page view displays with a 
summary of usage for every CarChip data logger associated with the CarChip software and a monthly 
summary of vehicle and driver information. 

The CarChip Home Page contains the following information: 

CarChip Table 
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The CarChip table contains information about the CarChip data logger(s) associated with the CarChip 
software. The information displayed in this table is: 

 

Table Row: Description: 

CarChip Displays the CarChip data logger serial number or unique name. 

Last Downloaded Displays the date the CarChip data was last downloaded. 

Vehicle Displays the vehicles that have been associated with connection events to the 
CarChip data logger. If there is more than one vehicle associated with the 
CarChip, the word Multiple displays. 

Driver Displays the drivers that have been associated with connection events to the 
CarChip data logger. If there is more than one driver associated with the 
CarChip, the word Multiple displays. 

Monthly Summary 
The Monthly summary displays vehicle and driver statistics available for the current month. To display 
vehicle information for other months, click Previous or Next.  

Vehicle Summary  
The Vehicle Summary table contains vehicle information for the current month. The information displayed 
in this table is: 

 

Table Row: Description: 

Vehicle Displays the VIN number or unique name for the vehicle. Contains a hyperlink for 
displaying detailed information about the vehicle. 

Distance Displays the total distance  the vehicle was driven with the CarChip data logger 
connected to the vehicle for the selected month. 

High Speed Displays the highest speed the vehicle logged for the selected month. 

Fuel Efficiency Displays the average miles per gallon, or liters per 100 Km for the vehicle for the 
selected month. The Fuel Efficiency for your vehicle is determined by the 
information you enter in the Fuel Entry dialog box. 

Fuel 
Expense/Mile 

Lists the price per mile or KM it costs to fuel the vehicle for the selected month. 
The Fuel Expense/Mile for your vehicle is determined by the information you 
enter in the Fuel Entry dialog box. 

Driver Summary  
The Driver Summary table contains driver information for the current month. The information displayed in 
this table is: 

 

Table Row: Description: 

66 



Welcome to CarChip 

Driver Displays the unique name for the driver. Contains a hyperlink for displaying 
detailed information about the driver. 

Distance Displays the total distance the driver drove with the CarChip data logger 
connected to the vehicle for the selected month. 

High Speed Displays the highest speed the driver logged for the selected month. 

Acceleration 
Events /100 
miles or 100km 

Displays the number of all hard and extreme acceleration events that took place 
over the most recent 100 miles or 100 kilometers.  

Deceleration 
Event /100 miles 
or 100km 

Displays the number of all hard and extreme acceleration events that took place 
over the most recent 100 miles or 100 kilometers. 

Top Speed Band Displays the total time the driver spent driving over the top speed band limit for 
the selected month. 

 

See Also: 

Vehicle Summary Page 

Driver Summary Page 

 

Back to View Menu Commands 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Home Page Driver Summary View 
The Home Page Driver Summary view displays when you select a Driver hyperlink from the Driver 
Summary table in the CarChip Home page. The Driver Summary displays detailed information about the 
selected driver for the selected month on the CarChip Home page.  

Driver Summary Table 

The Driver Summary table contains driver statistics for selected time intervals.  The information displayed 
in this table is: 

 

Table Row: Description: 

Time Interval Displays the periods of time that cover the driver statistics. The time intervals are: 

This Month 

Last Month 

Last 3 Months 

Last 6 Months 

Last 12 Months 

Distance Displays the total distance the driver covered with the CarChip data logger 
connected to the vehicle. 
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High Speed 

 

Displays the highest speed that was recorded for the driver for the time interval. 

Acceleration 
Events /100 
miles or 
100km 

Displays the number of all hard and extreme acceleration events that took place 
over the most recent 100 miles or 100 kilometers.  

Deceleration 
Event /100 
miles or 
100km 

Displays the number of all hard and extreme acceleration events that took place 
over the most recent 100 miles or 100 kilometers. 

Top Speed 
Band 

Displays the total time the driver spent driving over the top speed band limit during 
the displayed time periods. 

 

Back to CarChip Home Page | View Menu Commands 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Home Page Vehicle Summary View 
The Home Page Vehicle Summary page displays when you select a Vehicle Hyperlink from the Vehicle 
Summary table in the CarChip Home page. The Vehicle Summary displays detailed information about the 
selected vehicle for the month displayed in the CarChip Home page.  

Vehicle Use Overview Table 

The Vehicle Use Overview table contains vehicle usage statistics for selected time intervals.  The 
information displayed in this table is: 

 

Table Row: Description: 

Time 
Interval 

Displays the periods of time that cover the vehicle statistics. The time intervals are: 

This Month 

Last Month 

Last 3 Months 

Last 6 Months 

Last 12 Months 

Distance Displays the total distance  the vehicle was driven with the CarChip data logger 
connected to the vehicle. 

High Speed 

 

Displays the highest speed the vehicle logged for the time interval. 

Fuel 
Efficiency 

Displays the average miles per gallon, or liters per 100 Km for the vehicle for the 
selected month. The Fuel Efficiency for your vehicle is determined by the information 
you enter in the Fuel Entry dialog box. 

Fuel Lists the price per mile or KM it costs to fuel the vehicle for the selected month. The 
Fuel Expense/Mile for your vehicle is determined by the information you enter in the 
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Expense/Mile Fuel Entry dialog box. 

Parameter Summaries 

The Parameters summary displays available parameter statistics for you car based on the time intervals 
displayed in the Vehicle Use Overview table. The information displayed in these tables are: 

 

Table Row: Description: 

Parameter Displays the name of the parameter that was monitored for the time 
period. 

Threshold Displays the maximum threshold value set for the selected parameter for 
the time period being displayed.  

Time Over Thresh 
(Threshold) 

Displays the total time the vehicle spent over the maximum threshold. 

Time Under Thresh 
(Threshold) 

Displays the total time the vehicle spent under the maximum threshold. 

High Above Threshold Displays the highest value recorded above the threshold, if any exists for 
the time period being displayed. 

Low Below Threshold Displays the lowest value recorded below the threshold. 

   
Back to CarChip Home Page | View Menu Commands 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Trip Log Views 
The Trip Log Views allow you to look at the vehicle data recorded by your CarChip. Select a topic below to 
learn more about the Trip Log Summary, Trip Log Report View, Trip Log Plot View, and the Trip Log Table 
View. 

 

Trip Log Summary 

Trip Log Report View 

Trip Log Plot View 

Trip Log Table View 

 

Back to View Menu Commands 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Trip Log Plot View 
The Accident Log Plot View displays line graphs of all the available trip data. 
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Note: The trip data that displays in the plot view depends on CarChip data logger model.  The basic 
CarChip plots only the vehicle speed. The CarChip E/X or higher model plots the data for any additional 
parameters you have selected. 

To view the Trip Log Plots: 

1. Click on the Trip Log View icon or select Trip Log from the View menu. The Trip Log Summary view 
displays. 

2. Click on the Trip Log drop-down box to display a list of all the trips recorded in the Trip Log. The 
drop-down list box always begins with the Summary view, with each recorded trip listed in order 
below the Summary. 

 

3. Select one of the Trips records listed in the drop-down list by placing the cursor over it to highlight 
the stop, then clicking with the left mouse button. You can also select trip records by using the up 
and down cursor keys to move up and down the list, then pressing Enter when you have highlighted 
the desired stop.   
 
The Trip Log Report view displays. 

4. Use the Right or Left cursor key to select the Plot view of the record, or click the Plot button. The 
Trip Log Plot view displays. 
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5. Click the Left Arrow button or press the Up cursor key to display the previous Trip Log record. 

6. Click the Right Arrow button or press the Down cursor key to display the next Trip Log record. 

7. Use the Left and Right cursor keys to select the Report or Table views of the record.  

8. Click the Down Arrow button to display the next plot available for the selected trip. 

9. Click the Up Arrow button to display the previous plot for the selected trip, or use the scroll bar to 
display the different plot views. 

10. Click Comments to either view or edit a comment for the current record. 

11. Click Options to change the Accident Log Plot View setup options. 

See Also: 

Plot View Mouse Commands 

Trip Log Summary View 

Trip Log Report View 

Trip Log Table View 

Comments 

Options 

Plot View Navigation Buttons:    

 

Back to View Menu | Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Trip Log Plot View Mouse Commands 
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The following mouse commands are available in Trip Log Plot view: 

Left Button Commands: 

The following commands are available using the Left Mouse button: 

Zoom  

Right-Click Menu Commands: 

The Right-Click Menu commands are available in the Trip Log Plot view: 

 

• Unzoom 

• Copy As 

• Save As 

• Speed Bands - Select to include horizontal lines indicating speed band settings. 

• Braking Events - Select to draw vertical lines indicating braking events that exceed a braking 
threshold. 

• Acceleration Events - Select to include vertical lines indicating acceleration events that exceed an 
acceleration threshold. 

• Line Plot - Select to draw plots using plain lines. If not selected the area under the lines is filled in 
with black. 

• Plot Coordinates - Select to display the cursor coordinates inside the plot view window. 

• Normalize Axes - Select to use the same upper speed range for all Speed Plots.  The upper end of 
the speed range is set in the Setup / Plots dialog box. Click the Options button in the plot window 
to change the upper speed range. 

• Help F1 

 

Back to Trip Log Plot View 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Trip Log Table View 
The Trip Log Table view displays the all the values, including vehicle speed and any other selected 
parameters, that were sampled by the CarChip data logger through the duration of the trip.  
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Note: The trip data that displays in the table view depends on CarChip data logger model.  The basic 
CarChip displays only the vehicle speed in the table view. The CarChip E/X or higher model displays the 
data for any additional parameters that have been selected. 

To view the Trip Log Table: 

Click the Trip Log View icon or Select  Trip Log from the View menu. The Trip Log Summary view 
displays. 

1. Click on the Trip Log drop-down box to display a list of all trips recorded in the Trip Log. The drop-
down list box always begins with the Summary view, with each recorded trip listed in order below the 
Summary. 

 

2. Select one of the trip records listed in the drop-down list by placing the cursor over it to highlight the 
trip, then clicking with the left mouse button. You can also select trip records by using the Up and 
Down cursor keys to move up and down the list, then pressing Enter when you have highlighted the 
desired trip. The Trip Log Report view displays. 

3. Use the Right or Left cursor key to select the Table view of the record, or click the Table button. 
The Trip Log Table view displays. 
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4. Click on the Right Arrow button or press the Down cursor key to display the new Trip Log record. 

5. Click on the Left Arrow button or press the Up cursor key to display the previous Trip Log record.  

6. Use the Right and Left cursor keys to select the Plot and Report views of the record, or, just click 
the Plot or Report button.  

7. Click on Comments to either view or edit a comment for the current record. 

8. Click on Options to change the Trip Log Plot View setup options. 

 

See Also: 

Right Click Menu Options 

Trip Log Summary View 

Trip Log Plot View 

Trip Log Table View 

Trip Record Comments 

Plot Setup Options 

Trip Log Navigation Buttons    

 

Back to View Menu | Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Trip Log Report 
The Trip Log Report view displays expanded summary trip information for each trip recorded on the 
CarChip data logger. 
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To view the Trip Log Report: 

1. Click on the Trip Log View icon or select Trip Log from the View menu. The Trip Log Summary view 
displays. 

2. Click on the Trip Log drop-down box to display a list of all trips recorded in the Trip Log. The drop-
down list box always begins with the Summary view, with each recorded trip listed in order below the 
Summary. 

 

3. Select one of the trip records listed in the drop-down box by clicking enter once you have selected 
the desired trip. You can also scroll through trip records by using the Up and Down cursor keys.  
 
The Trip Log Report view displays.  
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4. Click on the Right Arrow button or press the Down cursor key to display the next Trip Log report.  

5. Click on the Left Arrow button or press the Up cursor key to display the previous Trip Log report. 

6. Use the Left and Right cursor keys to select the Plot or Table views of the record.  

7. Click on Comments to either view or edit a comment for the current record. 

8. Click on Options to change the Accident Log Plot View setup options. 

9. Click on Comments to either view or edit a comment for the current record. 

10. Click on Options to change the Trip Log Plot View setup options. 

 

See Also: 

Right Click Menu Options 

Trip Log Summary View 

Trip Log Plot View 

Trip Log Table View 

Trip Record Comments 

Plot Setup Options 

Trip Log Navigation Buttons    

 

Back to View Menu | Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 
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Trip Log Summary 
The Trip Log Summary view displays basic trip information. 

To view the Trip Log Summary: 

1. Click on the Trip Log View icon or select Trip Log from the View menu. The Trip Log Summary view 
displays. 

 

 

See Also: 

Right Click Menu Options 

Trip Log Report View 

Trip Log Plot View 

Trip Log Table View 

Trip Record Comments 

Plot Setup Options 

Trip Log Navigation Buttons    

 

Back to Home | View Menu 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Activity Log View 
The Acti
learn mo

vity Log View displays all the activity events recorded by your CarChip. Select a topic below to 
re about the Activity Log Summary and the Activity Log Event View. 
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Activity Log Summary 

Activity Log Event View 

nds 

ols | View | Help | Shortcuts 

 

ity Log Event View 
isplays the activity information including any comments. 

 

Back to View Menu Comma

 

Home | File | Setup | CarChip | To

Activ
The Activity Log Event view d

To view an Activity Log Event: 

1. Click the Activity Log icon or select Activity Log from the View menu. The Activity Log Summary 
view displays. 

2. Click the Activity Log drop-down box to display a list of all events recorded in the Activity Log. The
drop-down list 

 
box displays the Summary view when the Activity Log is displayed, with each 

recorded event listed in order below the Summary. 

 

3. Sel n list by placing the cursor over it to highlight 
the so, use the Up and Down cursor keys in the 

ect one of the event records listed in the drop-dow
event, then clicking with the left mouse button. Al

drop down box to display each event. 
 
The selected Activity Log Event view displays. 
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4. Click Comments to either view or edit a comment for the current record. 

The Activity Log Plot View displays a line graph of the vehicle speed data recorded during the 20 seconds 
prior to the stop.  

 

See Also: 

Right Click Menu Options 

Activity Log Summary View 

Comments 

 

Back to View Menu | Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Activity Log Summary View 
The Activity Log Summary displays all the activities recorded for the currently loaded CarChip database.  

To view the Activity Log Summary: 

1. Click the Activity Log View icon or select Activity Log from the View menu. The Activity Log 
Summary view displays. 

 

 

See Also: 

Right Click Menu Options 

Activity Log Event View  

Comments 

 

Back to View Menu | Home 
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Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

Accident Log Views 
The Accident Log Views allow you to look at the accident data collected by your CarChip. CarChip defines 
an accident as a stop in which the rate of deceleration exceeds either the hard braking or the extreme 
braking thresholds. 

Select a topic below to learn more about the Accident Log Summary, Accident Log Report View, Accident 
Log Plot View, and the Accident Log Table View. 

Accident Log Summary 

Accident Log Report View 

Accident Log Plot View 

Accident Log Table View 

 

Back to View Menu Commands 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Accident Log Plot View 
The Accident Log Plot View displays a line graph of the vehicle speed data recorded during the 20 seconds 
prior to the stop.  

To view the Accident Log Plots: 

1. Click the Accident Log View icon or select Accident Log from the View menu. The Accident Log 
Summary view displays. 

2. Click the Accident Log drop-down box to display a list of all stops recorded in the Accident Log. The 
drop-down list box always begins with the Summary view, with each recorded stop listed in order 
below the Summary. 
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3. Select one of the stop records listed in the drop-down list by placing the cursor over it to highlight 
the stop, then clicking with the left mouse button. You can also select stop records by using the up 
and down cursor keys to move up and down the list, then pressing Enter when you have highlighted 
the desired stop. 
 
The Accident Log Plot view displays. 

4. Use the Right or Left cursor key to select the Plot view of the record, or click the Plot button. The 
Accident Log Plot view displays. 
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5. Click the Left Arrow button or press the Up cursor key to display the previous Accident Log record. 

6. Click the Right Arrow button or press the Down cursor key to display the next Accident Log record. 

7. Use the Left and Right cursor keys to select the Report or Table views of the record.  

8. Click Comments to either view or edit a comment for the current record. 

9. Click Options to change the Accident Log Plot View setup options. 

   
See Also: 

Plot View Mouse Commands 

Accident Log Summary View 

Accident Log Report View 

Accident Log Table View 

Accident Record Comments 

Plot Setup Options 

Accident Log Navigation Buttons    

 

Back to View Menu | Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Accident Log Plot View Mouse Commands 
The following mouse commands are available in Accident Log Plots.  

Left Button Commands: 
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• Zoom  

Right-Click Menu: 

 

• Unzoom 

• Copy As 

• Save As 

• Line Plot 

Select to draw plots using plain lines. If not selected the area under the lines will be filled in. 

• Plot Coordinates  

Select to display the cursor coordinates inside the plot view window. 

• Normalize Axes 

Select to use the same upper speed range for all Speed Plots.  

The upper end of the speed range  is set in the Setup / Plots dialog box - Click Options button in plot 
window. 

• Help F1 

 

Back to Accident Log Plot View 

   
Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

 

 Accident Log Report View 
The Accident Log Report view displays the accident event information such as CarChip ID and speed. 

To view the Accident Log Report: 

1. Click on the Accident Log View icon or select Accident Log from the View menu. The Accident Log 
Summary view displays. 

2. Click on the Accident Log drop-down box to display a list of all stops recorded in the Accident Log. 
The drop-down list box always begins with the Summary view, with each recorded stop listed in 
order below the Summary. 
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3. Select one of the stop records listed in the drop-down box by placing the cursor over it to highlight 
the stop, then clicking with the left mouse button. You can also scroll through stop records by using 
the Up and Down cursor keys.  
 
The screen displays the Accident Log Report view .  
 
To display the next Accident Log record, click on the Right Arrow button or press the Down cursor 
key.  
 
To display the previous Accident Log record, click on the Left Arrow button or press the Up cursor 
key. 
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4. Use the Left and Right cursor keys to select the Plot or Table views of the record.  

5. Click on Comments to either view or edit a comment for the current record. 

6. Click on Options to change the Accident Log Plot View setup options. 

See Also: 

Right Click Menu Options 

Accident Log Summary View 

Accident Log Plot View 

Accident Log Table View 

Accident Record Comments 

Plot Setup Options 

Accident  Log  Navigation Buttons    

 

Back to View Menu | Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Accident Log Summary View 
The Accident Log Summary view displays the date and time, the CarChip ID, and the maximum speed 
recorded for each stop in the Accident Log. 

To view the Accident Log Summary: 
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1. Click on the Accident Log View icon or select Accident Log from the View menu. The Accident Log 
Summary view displays. 

 

2. Click on the Accident Log drop-down box to display a list of all stops recorded in the Accident 
Log. The drop-down box always begins with the Summary view, with each recorded stop listed in order 
below the Summary. From the Summary View you can click on the Summary drop-down list box to display 
a list of all stops recorded in the Accident Log. 
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3. Select a stop record by placing the cursor over it to highlight the stop, then clicking with the left 
mouse button.  You can also scroll through stop records using the Up and Down cursor keys or using the 
wheel on your mouse. 

4. The selected record is displayed in the Accident Log Report view. 

 

See Also: 

Right Click Menu Options 

Accident Log Report View 

Accident Log Plot View 

Accident Log Table View 

Accident Record Comments 

Plot Setup Options 

Accident Log Navigation Buttons    

 

Home | File | Setup | CarChip | View | Help | Shortcuts 

Accident Log Table View 

 

Back to View Menu | Home 
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The Accident Log Table view displays the vehicle speed over the 20 seconds prior to the stop. 

To view the Accident Log Table: 

1. Click the Accident Log View icon or Select  Accident Log from the View menu. The Accident Log 
Summary view displays. 

 

2. Click on the Accident Log drop-down box to display a list of all stops recorded in the Accident Log. 
The drop-down list box always begins with the Summary view, with each recorded stop listed in 
order below the Summary. 
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3. Select one of the stop
the stop, then clickin

 records listed in the drop-down list by placing the cursor over it to highlight 
g with the left mouse button. You can also select stop records by using the Up 

o move up and down the list, then pressing Enter when you have 
d stop. The Accident Log record view displays. 

 cursor key to select the Table view of the record, or click the Table button. 
able

and Down cursor keys t
highlighted the desire

4. Use the Right or Left
The Accident Log T  view displays. 
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5. Click on the Right Arrow button or press the Down cursor key to display the new Accident Log 
record. 

6. Click on the Left Arrow button or press the Up cursor key to display the previous Accident Log 
record.  

7. Use the Right and Left cursor keys to select the Plot and Report views of the record, or, just 
click the Plot or Report button.  

 

See Also: 

Right Click Menu Options 

Accident Log Summary View 

Accident Log Report View 

Accident Log Plot View 

 

Back to View Menu | Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Vehicle Trouble Log View 
The Vehicle Trouble Log View displays all the internal vehicle problems detected by your CarChip. Select a 
topic below to learn more about the Vehicle Trouble Log Summary and the Vehicle Trouble Log Problem 
View. 

 

Vehicle Trouble Log Summary 

Accident Record Comments 

Plot Setup Options 

Accident Log Navigation Buttons    
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Vehicle Trouble Log Problem View 

 

Back to View Menu Commands 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Vehicle Trouble Log Summary View 
The Vehicle Trouble Log Summary displays a summary of all the problems and trouble codes that were 
logged while the CarChip data logger was connected to a vehicle or vehicles. 

To view the Vehicle Trouble Log Summary: 

1. Click the Vehicle Trouble Log View icon or select Trouble Log from the View menu.  
 
The Vehicle Trouble Log Summary view displays. 

 

2. Click on the Vehicle Trouble Log drop-down list box to display a list of all problems recorded in 
the Vehicle Trouble Log. The drop-down list box always begins with the Summary view, with each 
etected problem listed in order below the Summary. d
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3. Select one of the trouble log records from the drop-down list by placing the cursor over the 
record and clicking the left mouse button. You can also scroll through the records by using the Up and 
Down cursor keys. 

The vehicle trouble log problem view displays.  

 

See Also: 

Right Click Menu Options 

Vehicle Trouble Log Problem View 

Comments 

 

Back to View Menu | Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Vehicle Trouble Log Problem View 
The Vehicle Trouble Log Problem View displays any problems detected with the vehicle or vehicles the 
CarChip data logger has been connected with. Any problem that is detected includes a trouble code and a 
brief description. 

To view the Vehicle Trouble Log Problem View: 

1. Click the Vehicle Trouble Log View icon or select Vehicle Trouble Log from the View menu.  
 
The Vehicle Trouble Log Summary displays. 
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2. Click the Trouble Log drop-down list box to display a list of all problems recorded in the Vehicle 
Trouble Log. The drop-down list box always begins with the Summary view, with each detected 
problem listed in order below the Summary. 

 

3. Select one of the problem records listed in the drop-down list by placing the cursor over it to 
highlight the event, then clicking with the left mouse button. You can also scroll through the Problem 
records by using the Up and Down cursor keys. 
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The Vehicle Trouble Log Problem view displays. The Problem View may include a "freeze frame" 
snapshot of the vehicle data at the time the problem was detected, depending on the behavior of the 
vehicle. 

 

4. Select Comments to either view or edit the comments for the problem. 

 

See Also: 

Right Click Menu Options 

Comments 

 

Back to View Menu | Home 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

OBDII Freeze Frame 
The Trouble Log Problem View displays the date and time the problem was detected, the trouble code, and 
also a description of the problem. Some vehicles will also include a detailed OBDII freeze frame, which 
reports the vehicle status at the time the problem was detected. 

The OBDII Freeze Frame includes some or all of the following information, depending on the make, model 
and year of the vehicle: 

• Time and Date 

Problem View Freeze Frame 

Vehicle Trouble Log Summary View 
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• Vehicle ID 

• CarChip ID 

• Trouble Code 

• Problem Description 

• Fuel Pressure 

• Intake Manifold Pressure 

• Engine Coolant Temperature 

• Calculated Load Value 

• Engine Speed 

• Vehicle Speed 

• Fuel Trim Status 

• Fuel System Status 

 

See Also: 

Trouble Log Summary View 

Comments 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

y Log 
The Summary Log displays the vehicle parameter data recorded by the CarChip data logger for every 

 the summary log mary log, or delete all summary 
this dialog box.  

Back to Home | Trouble Log View Menu | What is OBDII 

 

Summar

trip. View
logs from 

 available for each trip, go directly to a sum

Note: This menu command is only available for CarChip Models E/X or higher. 

To view the Summary Log: 

t Summary Log f mary Log1. Selec rom the View Menu. The Sum  dialog box displays. 
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The Summary Log contains the following fields and boxes: 

Field Description 

Record Displays the number of summary records that currently exist in the 
summary log 

Driver Displays the unique name for the driver. 

Vehicle Displays the unique name for the vehicle. 

CarChip Displays the CarChip data logger serial number or unique name. 

Start Time Displays the trip's start time. 

End Time Displays the trip's end time. 

Duration Displays the trip's duration. 

Distance Displays the total distance of the trip. 

Avg. Speed Displays the average speed. 

Max Speed Displays the maximum speed, or highest speed that was recorded during 
the trip. 

Parameter Name Displays the name of the parameter that was selected for monitoring.  

Threshold Displays the maximum threshold value for the parameter. 

Max Value Above Displays the value the CarChi ed that was over the set threshold p record
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Threshold value. 

Time Above Threshold Displays the total time the vehicle spent over the threshold value. 

Min Value Below Displays the value the CarChip recorded that was the lowest value under 
the set threshold. Threshold 

Time Below Threshold Displays the total time the vehicle spent under the threshold value. 

OK Click to close the summary log view. 

Delete All Click to delete all the records present in the summary log. 

Go To Click to display a specific record number. 

Previous Click to view the previous record. 

Next Click to view the next record. 

Help Click to receive context sensitive help for this dialog box. 

2. Click OK to close the Summary Log dialog box. 

 Click OK to close the Summary Log dialog box. 

To Delete all records: 

1. Click Delete All. All the available records are deleted. 

2.

Note: Deleting all the records displayed in the Summary Log may impact the information displayed in the 
CarChip Home Page and corresponding pages. Review the statistics and data displayed in these pages 
before deleting all the summary log information. 

Back to View Menu Commands 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Comments 
dialog box provides functionality for adding comments to each individual trip, activity, 

ccident, or trouble record.  

uble record that requires a comment. Use the drop down box 
 log view to display the record. 

2. Select the Comments button when the record displays. The Comments

The Comments 
a

To display or edit the comments for a record: 

1. Display the trip, activity, accident or tro
containing all the records for the current

 dialog box displays. 
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3. Enter new comments or edit existing comments. 

4. Click OK to save the comments or click Cancel to exit the dialog box without saving the comment 
changes. 

 

See Also: 

Trip Log Summary View 

a o View Menu | Home 

ome | File | Setup | CarChip | Tools | View | Help | Shortcuts 

nds 

ip Help menu lets you access the CarChip Help and CarChip Version Information. The Help 
enu contains the following: 

g CarChip Help for more information about 
using the Help window. 

k the window to close it and re-display the CarChip software. 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

n on Older Model CarChips 

tion on Disco  
ips 

tinues to improve a ng these 
changes are vehicle compatibility and product enhancements. The following product numbers show the 

iscontinued versions of CarC

Use CarChip (# 8210, 8211) for:  

• Troubleshooting your car - Records trouble codes and displays freeze frames of sensor readings. 

ar's performance rds acceleration, deceleration, and speed.  

Accident Log Summary View 

Security Log Summary View 

Trouble Log Summary View 

 

B ck t

 

H

 

Help Menu Comma

Help Menu Commands 
The CarCh
m

• CarChip Help - Opens the CarChip Help window. See Usin

• About CarChip - Displays version information for the CarChip hardware, firmware, and software. 

To display the CarChip Help Window: 

1. Select CarChip Help from the Help menu or click Help from the toolbar. The Help window displays. 

To display the About CarChip Window: 

1. Select About CarChip from the Help menu. The About CarChip window displays. 

2. Clic

Back to Home 

 

Informatio

Informa ntinued and Older Model
CarCh

Davis Instruments con nd update our CarChip product and software. Amo

features for d hip.  

• Logging your c - Reco
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• Recording trip information - Reco ts and stops, and distance. 

• Clearing your car's check engine light - Checks your car's sensors and turns off the check engine 

Use CarChip E/X (# 8220, 8221) for all the features of the CarChip plus: 

• Engine performance data logging  up to 4 of 23 available data parameters. 

ing an Accident Log for every stop. 

Use CarChip E/X with Alarm (# 8225) for all the features of CarChip E/X plus: 

 driver when speed, braking, and acceleration thresholds have been 
exceeded - Gives off an audible alarm when thresholds have been broken. 

 8240, 8241, 8244, 8

• Downloading car information to both the CarChip software and the DriveRight Fleet 
re (# 8186) 

See Also: 

r Model CarChip to a Co

Older Model CarChip Specifications 

Back to Getting Started 

 

| View

CarChip, CarChip E/X, 
CarChip Fleet, CarChip ns 

 pertain to the CarChip (# 8211) and CarChip E/X (# 8221) CarChip E/X with 
Alarm (# 8225), CarChip Fleet (# 8241)and CarChip Fleet with Alarm (# 8245) models of the CarChip. 

ons for specifications on the CarChip Pro (# 8226) and CarChip Fleet Pro (# 
. 

mperature  to +85°C) 

rds dates, star

light. 

 - Log

• Creat  hard and extreme 

• Announcing to

Use CarChip Fleet  (# 245) for all the features of CarChip plus: 

Management Softwa

 

Connecting an Olde mputer 

 

Home | File | Setup | CarChip | Tools  | Help | Shortcuts 

and CarChip E/X with Alarm, 
 Fleet with Alarm Specificatio

The following specifications

See CarChip Pro Specificati
8246) models of CarChip

General 

Operating Te -40° to +185°F  (-40°

Primary Power, Connected to Vehicle 12 VDC  

Primary Power
Computer 

, Connected to USB powered 

Backup Power Internal battery, 10-15 year life in normal use 

Memory 128KB for CarChip, 512KB for CarChip E/X 

Memory Storage 75 hours for CarChip, 300 hours for CarChipE/X) 

Time & Date Accurate to +/- 2 seconds per day 

Vehicle Interface 16-pin OBDII connector 

Computer Interface USB 
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Computer Cable Length 5' (1.5 m) 

Indicator Lamp LED, pulses to indicate unit status 

Dimensions 1.8" wide  x  1 " tall x  1.25" deep" (46 mm x 25.4 mm x 3
mm) 

2 

Weight 0.9 oz. (2.55g) 

OBDII Compatibility 

Supported Protocols  J1850-41.6, J1850-10.4, ISO9141, KWP2000 (ISO 14230), 
CAN (Control Area Network ISO 11898) 

CarChip Compatible Vehicles:  

US-Market  estic and import vehicles, 1996 or later. Most dom

European-Market  Some 1996 and later vehicles and most 2000 and later 
vehicles compliant with the supported protocols listed above. 

Elsewhere  Undetermined. Some 1996 and later vehicles that are 
compliant with the supported protocols may be CarChip 
Compatible. 

Incompatible US Market Vehicles *  CarChip meets and complies with most of the supported 

See the Incompatible Vehicle List

protocols used with US market vehicles. Despite this, 
incompatibilities still exist. Review the General CarChip 
Exclusions List to see the known exceptions, exclusions and 
anomalies. 

 for more information. 

* As of publication date. 

Software Requirements 

Operating System  Wi  XP, Vista ndows 95, 98, ME, NT 4.0, 2000,

Disk Space  5 MB free disk space 

Display  Windows-compatible VGA minimum 

Data Display 

Trip Log Summary View  Start date and time, duration, distance, max speed, time in 
eed band, number of hard braking events, number of 
e braking events, number of hard acceleration events, 

number of extreme acceleration events, vehicle ID 

top sp
extrem

Trip Log Report View 
 sp d, 

me spent in second speed band, t ent in third speed 
band, time spent in fourth speed band, distance, average 

er of ents, 
number of extreme braking events, number of hard 

number of extr nts, 
ters (speed onl  5 

Vehicle ID, CarChip data logger ID, star
duration, time spent at idle, time
ti

t time, end time, 
ent in first speed ban

ime sp

speed, maximum speed, numb  hard braking ev

acceleration events, 
list of logged parame

eme acceleration eve
y for CarChip, up to
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parameters for CarChip E/X), comments 

Trip Log Plot View Line graph for vehicle speed. CarChip E/X includes line 
graphs for up to four additional parameters 

Trip Log Table View sed time for trip and speed up to ev Up to 
other parameters every 5, 10, conds for 

CarChip E/X only 

Elap
four 

ery second. 
20, 30 or 60 se

Activity Log Summary View Date and time, CarChip ID, description 

Activity Log Event View Date and time, CarChip ID, description, comments 

Accident Log Summary View (CarChip Date and time, CarChip ID, maximum speed in log 
E/X only) 

Accident Log Stop View (CarChip E/X
only) 

, maximu
ments 

 Date and time, CarChip ID
com

m speed in log, 

Accident Log Plot View (CarChip E/X 
only 

ehicle 0 seconds 
prior to stop. 
Date and time, line graph of v  speed for 2

Accident Log Table View (CarChip E/X Vehicle speed for each of the 20 seconds prior to the stop. 
only) 

Trouble Log Summary View Date and time, vehicle ID, trouble c lem description ode, prob

Trouble Log Problem View Date and time, vehicle ID, CarChip ID, trouble code, problem 
, comments, OBDII freeze frame info (parameters 

r) 
description
included in freeze frame vary from car to ca

Data Options 

 

Supported Unit Systems  etric, S.I., custom U.S., M

Vehicle Speed Sampling Interval  1, 5, 10, 20, 30 or 60 seconds 

Other Parameters Sampling Intervals 
/X only)  

5, 10, 20, 30, or 60 seconds 
(E

Vehicle Speed Bands  4, user configurable, use to identify typical vs atypical 
vehicle operation 

Calculated Data  Hard and extreme braking, hard and extreme acceleration 

Data Parameters for CarChip and CarChip E/X  

Parameter  Range* Resolution* 

Vehicle Speed  0 to 158 mph, 0 to 255 kph, 0 to 70 0.6 mph, 1 kph, 0.3 
m/s  m/s 

Trip Distance Traveled  0 to 10,000 miles, 0 to 16,000 km 0.1 m, 0.1 km 

Acceleration/Deceleration 
Threshold  

0 to 3 G, 0 to 30 m/sec2 0.03 G, 0.3 m/sec2 
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*Range and resolution of sensor measurements only. Accuracy is dependent on the accuracy of the 
vehicle’s sensors. 

Data Parameters for CarChip E/X Only  

Parameter  Range* Resolution* 

Engine Speed  0 to 16,384 rpm 1 rpm 

Throttle Position  0 to 100%  0.1% 

Coolant Temperature  -40° to +420°F, -40° to +215°C 2°F, 1°C 

Engine Load  0 to 100% 0.1% 

Air Flow Rate  0 to 8714 lb/min, 0 to 655.35 
gm/sec 

0.1 lb/min, 0.01 
gm/sec 

Intake Air Temperature  -40° to +420°F, -40° to +215°C  2°F, 1°C 

Intake Manifold Pressure  0 to 75 in. hg., 0 to 255 kPaA 0.3 in. hg., 1 kPaA 

Fuel Pressure  0 to 110 psiG, 0 to 765 kPaG  0.5 psiG, 3 kPaG 

O2 Sensor Voltage (B1-2, S1-4, 
8 total) 

0 to 1.275 V 0.005 V 

Ignition Timing Advance  -64° to 63.5° 0.5° 

Short Term Fuel Trim  -100% to 99.22% 0.8% 

Long Term Fuel Trim -100% to 99.22% 0.8% 

Battery Voltage  6 to 16 VDC 0.1 VDC 

*Range and resolution of sensor measurements only. Accuracy is dependent on the accuracy of the
vehicle’s sensors. 

 

 

See also: 

Incompatible Vehicle List 

 

Back to How CarChip Works | More Information 

 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Connecting an Older Model CarChip to a Computer 

The older models of the CarChip data logger connect to your computer using a USB connection (# 8211, 
8221, 8225, 8241, 8245) or using a serial port connection (# 8210, 8220). See Connecting CarChip Pro to 
a Computer if you have a CarChip Pro or CarChip Fleet Pro (# 8226, 8246).  
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Note: The CarChip data logger does not have to maintain a constant connection with your computer. The 
CarChip can be connected and disconnected at any time the CarChip software is not downloading 
information from the CarChip data logger. 

To connect the CarChip data logger to your computer using a USB connector: 

1. Locate a free USB port on the front or back of your computer and insert the USB connector of the 
download cable into the USB port. 

2. Plug the microminiature connector into the port on the CarChip data logger. 

 

 

  
To connect the CarChip data logger to your computer using a serial port: 

ns for connecting earlier versions of the CarChip (products # 8210, # 8220) to a 

erial port on the back of your computer and insert the 9-pin connector of the 
e port. 

2. Plug the power adapter cable into the power jack on the 9-pin connector. 

wer supply into an AC outlet. 

iniature connector into the port on the CarChip data logger. 

The following instructio
 serial port connection:  

1. Locate a free s
download cable into th

 

3. Plug the po

4. Plug the 8-pin microm
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Back to Home | CarChip Installation 

 

ols | Vi rtcuts 

tion 

More Information Menu 

CarChip User's Guide 

el CarChip Specifications 

Prior Release Notes 

Incompatible Vehicle List 

What is OBDII? 

One Year Limited Warranty 

vis Instruments 

Back to Home 

Chip | View | He s 

hip Online Help P

n of the online help is pr  
CarChip software CD. The manual is also s a short cut on the Start Menu. 

 

 Information | Home 

Home | File | Setup | CarChip | To

 

ew | Help | Sho

More Informa

Click on a topic below to view help for a particular menu: 

CarChip Specifications 

Older Mod

Contacting Da

 

 

Home | File | Setup | Car lp | Shortcut

CarC rintable Document 

A printable versio ovided in the Adobe Acrobat file carchip.pdf located on the
provided a

Back to More
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Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

CarChip Pro and CarChip Fleet Pro Specifications 

The following specifications pertain to the CarChip Pro (# 8226) and CarChip Fleet Pro (# 8246) models of 
p. See CarChip (# 8211), CarC arm (# 8225) 

Specifications for specifications on older and discontinued CarChip Models. Also, check www.davisnet.com 
ions on all of our products. 

 

the CarChi hip E/X (# 8221) and CarChip E/X with Al

for updated specificat

Note: CarChip Software version 2.3 or later is required for both the CarChip Pro and CarChip Fleet Pro 
models of CarChip. 

General 

Operati ture -ng Tempera 40° to +185°F  (-40° to +85°C) 

Primary  to Vehicle 9
v

 Power, Connected  to 16 VDC, 80 mA with vehicle running, 17 mA with 
ehicle's power off 

Primary Power, Connected to 
Comput

USB powered 
er 

Backup Power I y, minimum of 5 years total, with data logger 
not powered by vehicle or computer; 10-15 year life in 
n

nternal batter

ormal use 

Memory 512KB for CarChip Pro, 2MB for CarChip Fleet Pro 

Data Logging Capacity for CarChip Pro 300 hours maximum, depending on logging intervals and 
number of optional parameters selected 

Data Logging Capacity for CarChip 
Fleet Pro 

1200 hours maximum, depending on logging intervals and 
number of optional parameters selected. Data logging 
capacity is determined by a combination of factors, such as 
logging intervals, number of optional parameters 
selected,and, if optional GPS is used, the logging interval 
used for GPS. Please see the CarChip Fleet Pro specification 
sheet on our website at www.carchip.com. 

Time & Date Accurate to +/- 2 seconds per day 

Vehicle Interface 16-pin OBDII connector 

Computer Interface USB 

Computer Cable Length 4' (1.2 m) 

Alarm Adjustable, audible alarm for exceeding speed, acceleration
and deceleration limits, wh

, 
en enabled in software.  

Indicator Lamp LED, flashes to indicate CarChip status, when enabled in 
software 

Dimensions 1.80" x 1.00" x 1.32" (46 mm x 26 mm x 34 mm) 
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Weight 0.7 oz. (20.5 g) 

Software Requirements 

Operating System  Windows 98SE, ME, NT 4.0, 2000, XP, Vista 

Disk Space  isk space 5 MB free d

Display  Windows-compatible VGA minimum 

OBDII Compatibility 

Supported Protocols *  J1850-41.6, J1850-10.4, ISO9141, KWP2000 (ISO 14230), 
CAN (Control Area Network ISO 11898) 

CarChip Compatible Vehicles:  

US-Market Most domestic and import vehicles, 1996 or later. 

European-Market Some vehicles model years 1996 - 1999 and most vehicles 
er vehicles compliant with the 
 above. 

model year 2000 and lat
supported protocols listed

Elsewhere Undetermined. Some 1996 and later vehicles that are 
compliant with the supported protocols may be CarChip 
Compatible. 

Incompatible US Market Vehicles *  CarChip meets and complies with most of the supported 

till exist. See the Incompatible Vehicle List
protocols used with US market vehicles. Despite this, 
incompatibilities s  to 
see the known exceptions, exclusions and anomalies.* 

*As of publication date. 

Data Display 

Trip Log Summary View  Start date and time, duration, distance, max speed, time in 
top speed band, number of hard braking events, number of 

me braking events, number of ion events, 
er of extreme acceleration even .. 

extre  hard accelerat
numb ts, vehicle ID

Trip Log Report View 
ion, time spent at idle, time spent in first speed band, 

time spent in second speed band, time spent in third speed 
d ba erage 

speed, maximum speed, number of hard braking events, 
raking events,

acceleration events, number of extreme acceleration events, 
list of logged parameters. 

Vehicle ID, CarChip data logger ID, star
durat

t time, end time, 

band, time spent in fourth spee nd, distance, av

number of extreme b  number of hard 

Trip Log Plot View Line graph for vehicle speed, and line graphs for up to four 
l parameters additiona

Trip Log Table View Elapsed time for trip and spee
seconds. Up to four other par

d eve , 20, 30, or 60 
amete  10, 20, 30 or 

60 seconds. 

ry 1, 5, 10
rs every 5,

Activity Log Summary View Date and time, CarChip ID, description of event 

106 



Welcome to CarChip 

Activity Log Event View , descript
ments 

Date and time, CarChip ID
com

ion of event, and 

Accident Log Summary View aximu  log Date and time, CarChip ID, m m speed in

Accident Log Stop View Date and time, CarChip ID, maximu
comments 

m speed in log, 

Accident Log Plot View Date and time, and corresponding line graph of vehicle speed 
conds prior to stop. for 20 se

Accident Log Table View Vehicle speed for each of the 20 seconds prior to the stop. 

Trouble Log Summary View Date and time, vehicle ID, trouble code, problem description 

Trouble Log Problem View Date and time, vehicle ID, CarChip ID, trouble code, problem 
mments, OBDII freeze frame info (parameters 

r) 
description, co
included in freeze frame vary from car to ca

Data Options 

Supported Unit Systems  U.S., Metric, S.I., custom 

Vehicle Speed Sampling Interval  1, 5, 10, 20, 30 or 60 seconds 

Other Parameters Sampling Intervals 5, 10, 20, 30, or 60 seconds 
  

Number of Optional Engine Data 23 total possib
arameters 

le as supported by vehicle, up to 4 can be 
selected at a time. P

Vehicle Speed Bands  4, user configurable, use to identify typical vs atypical vehicle 
operation 

Calculated Data  Hard and extreme braking, hard and extreme acceleration 

Data Parameters  

Parameter  Range* Resolution* 

Ve  Speed: 0 to 158 mph, 0 to 255 kph, 0 to 70 
m/s  

0.6 mph, 1 kph, 0.3 m/s hicle

Trip Distance Traveled: 0 to 10,000 miles, 0 to 16,000 km 0.1 m, 0.1 km 

Acceleration/Decel
Threshold 

eration 0 to 3 G, 0 to 30 m/sec2 0.03 G, 0.3 m/sec2 

Engine Speed  0 to 16,384 rpm 1 rpm 

Throttle Position  0 to 100%  0.1% 

Coolant Temperature  -40° to +420°F, -40° to +215°C 2°F, 1°C 

Engine Load  0 to 100% 0.1% 
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Air Flow Rate  0 to 8714 lb/min, 0 to 655.35 0.1 lb/min, 0.01 gm/sec 
gm/sec 

Intake Air Temperature  -40° to +420°F, -40° to +215°C  2°F, 1°C 

Intake Manifold Pressure  0 to 75 in. hg., 0 to 255 kPaA 0.3 in. hg., 1 kPaA 

Fuel Pressure  0 to 110 psiG, 0 to 765 kPaG  0.5 psiG, 3 kPaG 

O2 sor Voltage (B1-2, S1-4, 0 to 1.275 V 0.005 V  Sen
8 total) 

Ignition Timing Advance  -64° to 63.5° 0.5° 

Short Term Fuel Trim  -100% to 99.22% 0.8% 

Long Term Fuel Trim -100% to 99.22% 0.8% 

Battery Voltage  6 to 16 VDC 0.1 VDC 

*Range and re
vehicle’s sens

solution of sensor measurements only. Accuracy is dependent on the accuracy of the 
ors. 

See also: 

Incompatible Vehicle List 

 

Back to How CarChip Works | More Information 

 

Home 

Prio

CarChi

• Wh
your own D e: 

ns: Vehicle 
pecific Exceptions and OBDII Protocol Exceptions.  The Renault EOBD and Intermotive Compatibility 

a p Software version 2.3.1 Release Notes 

 The format of the Firmware and Bootware version numbers has changed to improve clarity. 

CarChip Software version 2.3 Release Notes 

| File | Setup | CarChip | Tools | View | Help | Shortcuts 

r Release Notes 

p Software version 2.3.2 Release Notes 

en a new custom measurement system is created in the Setup/Units dialog box, you can choose 
ate Format and Time format. The different date formats includ

• MM/DD/YYYY 

• DD/MM/YYYY 

• YYYY/MM/DD 

The different time formats include: 

• AM/PM 

• 24 Hour 

• The Anomalous Vehicles dialog box now includes two types of anomalous vehicle exceptio
S
vehicles are included in the Specific Vehicle Exceptions list in the Anomalous Vehicles dialog box. 

C rChi

CarChip Software version 2.3.1 includes the following change: 

•
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CarChip Software version 2.3 includes the following changes: 

• The CarChip software now processes VIN number read from vehicle (if there is one) during 
download. 

• Fixed issue with the CarChip software not detecting a connected CarChip when the software is 
first launched.  

box and corresponding vehicle report now display fuel information in both litres 
ending on unit type selected in the Units dialog box. 

• The CarChip Pro and CarChip Fleet Pro models of CarChip are now supported in this release. 

 Audible alarm volume can now be adjusted in the Set Alarm Volume dialog box for the CarChip 
ip. 

 for every model of CarChip and every firmware 
version. 

• Added Saturn Hybrids to the Anomalous Vehicles list. 

garding access being denied when a new .car file is created or an 
existing .car file is trying to be accessed if the current open file happens to be the Example.car 

• The list of possible trouble codes  displayed in the Trouble Log is updated according to SAE J2012 
(April 2002) and trouble codes recorded during the trip are processed more accurately. 

lease Notes 

ludes the following changes: 

ins 

have added to the CarChip software. Fuel entry information is used to calculate the price 

View. 

• Emissions Readiness - Displays the last recorded status of the emissions readiness codes 
for every vehicle in the CarChip Database. Use this dialog box to view whether or not a 
particular readiness code is supported for the vehicle and whether or not the monitor 

pleted its test for each of the available readiness codes. 

ype Entry - Lets you categorize the all the recorded trips by trip type and provides 
a mileage analysis of the types of trips taken. 

Notes 

arChip Software version 2.1 includes the following changes: 

kthrough process has been divided into 
two different processes: Express Setup and Full Setup. The Full Setup option provides all the 
same functionality of the Walkthrough process available in previous versions of the CarChip 
software. The Express Setup option is a shorter, quicker version of the walkthrough. 

 the European version of Windows OS. 

• Anytime a new driver or vehicle is added in the Add Driver or Add Vehicle dialog box, it is now 

user. 

• The Fuel Entry 
and gallons, dep

•
Pro and CarChip Fleet Pro models of Carch

• The default settings have been normalized

• Fixed issue regarding the Anomalous Vehicles list not displaying the selected car once it was 
selected. 

• An issue has been fixed  re

file. 

CarChip Software version 2.2 Re

CarChip Software version 2.2 inc

• The Tools Menu has been added to the menu options on the tool bar. The Tools Menu conta
three new options for organizing trip data and keeping track of readiness code information. These 
options are. 

• Fuel Entry - Lets you enter information about fuel usage and costs for every vehicle you 

you pay per mile for fuel and is displayed in the CarChip Home Page and Vehicle 
Summary 

com

• Trip T

CarChip Software version 2.1 Release 

C

• New Option in the Setup Menu's Walkthrough. The Wal

• Updated the software and firmware to support

assigned a sequentially numbered ID. 

• CarChip software automatically saves program data without being prompted by the 

CarChip Software version 2.0 Release Notes 

CarChip Software version 2.0 includes the following changes: 
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• This version of the software changed to add USB support. 

• The audible alarm available on the CarChip with Alarm (# 8225) and CarChip Fleet with Alarm 

ack to Getting Started 

me | File | Setup | CarChip | Tools | View | Help | Shortcuts 

ncompatible Vehicle List 

 updated listing of all the US market vehicles that are currently not compatible 
arChip Compatibility List for more information on the vehicles exclusions and 

conflicts for the CarChip model you are currently using. 

 
hat 

t vehicle emissions and many other vehicle functions and operations as well. Any detected 
t to be illuminated.  

 

lso: 

Back to Home | How CarChip Works 

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

Year Limited Warranty 

 date of 
ully manufacture our products to the highest 

be missing, defective, or damaged. 

ave a defective part, return the product to us, shipping charges prepaid. Include proof of purchase 
and a written explanation of the trouble. During the warranty period, we will, at our option, either repair 

Models (# 8245) can be toggled on an off from the CarChip Menu. 

• The Enable VIN feature can now be toggled on and off from the CarChip Menu. 

 

B

 

Ho

I

Davis Instruments keeps an
with the CarChip. See the C

 

Back to More Information | Home  
  

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

What is OBDII? 

OBDII, or "on-board diagnostics two", is the on-board automotive diagnostics system that has been 
required by the EPA on every new motor vehicle sold in the USA since 1996. OBDII is also found on many
vehicles sold internationally since 1996. The on-board diagnostics monitors virtually every component t
can affec
problems will be recorded by the system and will cause the vehicle's check engine ligh

OBDII is an outgrowth of earlier similar diagnostic systems which were created in the 1980's to monitor 
vehicle emission controls.  

See A

OBDII Freeze Frame 

CarChip Specifications 

 

 

 

One 

We warrant our products to be free of defects in material and workmanship for one year from the
original purchase. While we make every effort to caref
standards of quality, occasionally parts may be found to 

If you h

or replace the product free of charge. 
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This warranty does not cover damage due to improper installation or use, negligence, accident, or 
unauthorized service, or incidental or consequential damages beyond Davis products themselves. Implied 

ies are limited in duration to the life of the limited warranty. 

Some states do not allow limitations on how long an implied warranty lasts, or the exclusion or limitation 

country. 

Back to More Information | Home 

 CarChip | Tools | View | Help | Shortcuts 

afety Notice 

rChip has been carefully designed and tested to comply with OBDII protocols J1850-41.6, J1850-10.4, 
ich are used on most cars and light trucks 
e models are not in full compliance with 

ese protocols. In addition, the computer control systems on any given vehicle may be malfunctioning or 
c, as may be the sensors used by these systems. 

Before installing CarChip, be sure to review the list of known vehicle exclusions and anomalies on our 
website at www.carchip.com, where you’ll also find the latest software and firmware downloads. For more 
information on OBDII issues and anomalies in general, we recommend The Equipment and Tool Institute’s 
website at www.etools.org. 

While our testing and the experience of thousands of CarChip users have shown the unit to be safe and 
reliable, there is an inherent risk in adding any aftermarket product that may potentially affect the 
operation or drivability of your vehicle. Should you be concerned about the operation of your vehicle at 
any time while using CarChip, you should pull over, off the roadway, immediately or as soon as it is safe 
to do so. Remove CarChip from the OBDII port and consult a licensed mechanic or automobile service 
center. 

Report any issues or concerns to our Technical Support Dept. at (510) 732 7814 or 
support@davisnet.com. We are open Monday through Friday, 7:00 a.m. to 5:30 p.m. Pacific Time. We 
maintain an active database of the feedback we receive, and your comments can help us continuously 
improve the product. 

 

Back to More Information | Home 
  

Home | File | Setup | CarChip | Tools | View | Help | Shortcuts 

 

Contacting Davis Instruments 

Please contact Davis Technical Support if you have questions about your CarChip, or encounter problems 
installing or operating the CarChip. 

Phone 

(510) 732-7814 &endash; Monday &endash; Friday, 7:00 A.M. &endash; 5:30 P.M. Pacific Time 

(510) 670-0589 &endash; Technical Support Fax 

Email 

support@davisnet.com &endash; Technical Support email 

warrant

of incidental or consequential damages, so the above limitations may not apply to you. This warranty 
gives you specific legal rights. You may have other rights, which vary from state to state and country to 

 

  

Home | File | Setup |

 

S

Ca
ISO 9141, and KWP2000 (ISO14320), and CAN (ISO 11898) wh
sold in the USA, model-year 1996 or later. However, some vehicl
th
out of spe
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112 

info@davisnet.com &endash; Davis Instruments General email 

Web 

www.davisnet.com &endash; Copies of User Manuals are available on the &rdquor;Support” page. Watch 
for FAQs and other updates. Subscribe to the e-newsletter. 

Mail 

Davis Instruments 

3465 Diablo Avenue 

Hayward, CA 94545 

USA 
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